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About this Manual
This manual is divided in two parts, the first part gives instructions on how 
to set up and use your Nanosurf easyScan 2 STM system. The second part 
is a reference for the Nanosurf easyScan 2 Control Software. It applies to 
software version 1.6. If you are using a newer software version, try to down-
load a newer version of the manual from the Nanosurf support pages, or 
refer to the Whats new file that is installed in the Manuals subdirectory of 
the directory where the easyScan 2 software is installed. 

The first part of the manual starts with the chapter Installing the easyScan 2 
STM, which should be read when installing your easyScan 2 STM system. 
The chapters Preparing for Measurement and First Measurements should be 
read by all users, because they contain useful instructions for everyday 
measurements. The chapter STM Theory gives some general information 
on the scanning tunneling microscopy technique and its implementation in 
the easyScan 2 STM. The other chapters in this part give more information 
for advanced or interested users. 

The second part of the manual starts with chapter The user interface (p.76). 
This part is a description of the function of the buttons and inputs in the 
dialogs and control panels of the easyScan Control software. Chapter Quick 
Reference (p.154) gives links to the description of each Control Panel, Dia-
log, Menu item and Operating Window.

For more information on the optional Scripting interface, refer to the on-
line help file easyScan 2 Programmers Manual, that is installed together with 
the easyScan 2 software.

For more information on the optional Nanosurf Report software, refer to 
the on-line help, included with the Nanosurf Report software.



The easyScan 2 STM

The Nanosurf easyScan 2 STM was designed to allow people without train-
ing as a physicist to do experiments in the world of atoms. Its design is 
compact, simple and comfortable to operate. With the easyScan 2 STM, it 
is possible to do any STM experiment which can be carried out in air. The 
tip-sample approach stage allows simple handling of samples and tips, 
whilst at the same time providing maximum stability of the tip-sample dis-
tance. All functions can be carried out using a computer and the easyScan 
2 software.

The easyScan 2 STM system is a modular scanning probe system that can 
be upgraded to obtain more measurement capabilities. The main parts of 
the basic system are the easyScan 2 STM scan head, the Vibration Isolation 
Platform, the easyScan 2 Controller, and the easyScan 2 software. At the 
time of publication, the following parts can be used with the easyScan 2
system:

• AFM Scan Heads and modules used for AFM operation: can also make 
measurements on non-conducting samples. Refer to the easyScan 2 AFM 
Operating Instructions for more details.

• Signal Modules: allow monitoring signals (Module: S) and creating cus-
tom measurement modes (Module: A). Refer to chapter The Signal Mod-
ules (p.59) for more details.

• Nanosurf Report: software for simple automatic evaluation and reporting 
of surface measurements.

• Nanosurf Analysis: software for detailed analysis of Scanning Probe meas-
urements.

• Scripting Interface: software for automating measurements. Refer to the 
Software Reference and Programmers Reference for more details.

• TS-150 active vibration isolation table: reduces the sensitivity of the 
instrument to vibrations in its environment.
9
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Features

easyScan 2 Controller

Electronics

Control Software

Controller size / weight 470x120x80 mm / 2.4 kg
Power supply 90 - 240 V~/ 30 W 50/60 Hz
Computer interface USB 1.1 / 2.0 (Apr. controller serial number 

23-06-230 and higher)
Integrated USB hub 2 Ports (100mA max)
Scan generator 16 bit D/A converter for all axes
Scan speed Up to 60ms/line at 128 data points/line
Scan drive signals ± 10 V, no high voltage
Measurement channels 16bit A/D converters, up to seven signals 

depending on mode.
Scan area and data points Individual width/height, up to 2048 x 2048 

points
Scan image rotation 0 - 360°
Sample tilt compensation Hardware X/Y-slope compensation
Spectroscopy modes Single point measurement or multiple meas-

urements along vector
Spectroscopy measurement 
averaging

1 - 1024 times

Spectroscopy data points Up to 2048

Simultaneous display of data 
in charts types

Line graph, Color map, 3D view, …

User profiles Customisable display and parameter settings 
On-line processing func-
tions

Mean fit, Polynomial fit, Derived data, …

Quick evaluation functions distance, angle, cross section, roughness, …
Data export BMP, ASCII, CSV, …



FEATURES
Nanosurf easyScan 2 Scripting Interface

Computer requirements

Computer not included with system.

Nanosurf easyScan 2 Signal Module: S

Nanosurf easyScan 2 Signal Module: A

Applications Automating measurement tasks, lithography, 
custom evaluation functions, using third 
party measurement equipment

Included control software Windows Scripting Host: Visual Basic Script, 
Java Script, …

Remote control by COM compatible languages: LabView, 
MathLab, Visual Basic, Delphi, C++, …

Operating system require-
ment

Windows 2000, XP, Vista

Electronics interface USB port
Recommended PC hardware Pentium 4/M or AMD Athlon, 256MB 

RAM, True color > 1024x786 video card, 
HW Open GL accelerator

Available output signals X-Axis, Y-Axis, Z-Axis, Approach, Tip Volt-
age, STM Current or AFM Deflection, 
Excitation, Amplitude, Phase

Full scale corresponds to ±10 V, Excitation: ±5 V
Power supply output GND, +15 V, -15 V

Output signal All output signals of Signal Module: S
Additional analog user out-
puts

2x 16 bit D/A converters, ±10 V

Synchronisation output 1x TTL: start, end, point sync
Additional signal modulation 
inputs

X-Axis, Y-Axis, Z-Axis, Tip Voltage, Excita-
tion

Free connectors 2x Aux, connection made on user request
Modulation range ±10 V, Excitation: ±5 V
11
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User inputs can optionally be measured in all Imaging and Spectroscopy 
modes.

User outputs can be modulated in Spectroscopy measurements.

STM Measurement

1) These are typical values, the exact values are given on the calibration 
certificate that is delivered with the instrument.

2) Calculated by dividing the maximum range by 16bits; atomic resolution 
on HOPG can be obtained with all STMs

Components of the system

This section describes the parts that may be delivered with an easyScan 2 
STM system. The contents of delivery can vary from system to system, 
depending on which parts were ordered. To find out which parts are 
included in your system, refer to the delivery note shipped with your sys-
tem. Some of modules listed in the delivery note are built into the Control-

Additional analog user inputs 2x 16 bit A/D converters, ±10 V
Additional modes Almost unlimited

STM Scan Head: 500 nm 1 µm 500 nm LC 1 µm LC

Maximum Scan range1) 500 nm 1.0 µm 500 nm 1.0 µm

Maximum Z-range1) 200 nm 200 nm 200 nm 200 nm

Drive resolution Z2) 3 pm 3 pm 3 pm 3 pm

Drive resolution XY2) 7.6 pm 15 pm 7.6 pm 15 pm

Current set point 0.1-100 nA in 25 pA steps0.02-20 nA in 5 pA steps

Imaging modes Constant Current (Topography), Constant 
Height (Current)

Spectroscopy modes Current-Voltage, Current-Distance
Tip voltage ±10 V in 5 mV steps
Tip-sample approach Stick-slip piezo motor
Sample size max. 10 mm diameter



COMPONENTS OF THE SYSTEM
ler. Their presence is indicated by the status lights on the top surface of the 
Controller when it is turned on (see section Connectors, Indicators and Con-
trols (p.15)).

1. easyScan 2 Controller with built in optional Signal Module: A or S 
electronics, and other modules used for AFM operation

2. USB cable

3. Mains cable

4. easyScan 2 STM Scan head(s)

5. Magnifying cover with 10x magnifier

6. STM Calibration sheet

7. This easyScan 2 STM Operating Instructions manual

8. easyScan 2 Software Reference manual

9. easyScan 2 Installation CD: Contains software, calibration files, and 
PDF files of all manuals

10. STM Tool set (option). The contents of the STM Tool set are described 
in the next section.

Components: The easyScan 2 STM system

1

10

32

4 5
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11. Vibration isolation platform (option)

12. Break-out cable (with Signal Module: S)

13. Connector box (with Signal Module: A)

14. Signal Module cables (2x) (with Signal Module: A)

15. Scripting Interface Certificate of purchase with Activation key printed 
on it (with Scripting Interface)

16.  Instrument Case

The package may also contain easyScan 2 AFM head(s) and modules for 
AFM operation; these are described in the AFM Operating Instructions.

Additionally, a solvent (e.g. ethanol, acetone) is needed to clean the tools. 
This is not included with the contents of delivery.

Contents of the Tool set
The contents of the Tool set depend on the available modules. It may con-
tain:

1. Wire cutters

2. Flat Nose Pliers

3. Pointed tweezers: 00D SA

4. Rounded tweezers: 2A SA-SL

Contents of the STM Tool set

1

6

32 4 5

7 8



CONNECTORS, INDICATORS AND CONTROLS
5. Sample holder

6. Pt/Ir wire: 0.25mm/30cm for making tips (option)

7. STM Basic Sample Kit (option) with HOPG (graphite), gold thin film 
and four spare sample supports

8. USB dongle for the Nanosurf Report software (option)

Connectors, Indicators and Controls

Use this section to find the location of the parts of the easyScan 2 STM that 
are referred to in this manual.

The Scan head
Two types of seasyScan 2 STM Scan Heads exist, that have different 
approach stages. In type one stages, the sample holder slides on guide bars, 
in type two stage, the sample holder slides on a point support. The location 
of the parts in both scan heads is shown in figure Parts of the scan head.

The Controller

Status lights
All status lights on top of the Controller will light up for one second when 
the power is turned on.

Parts of the scan head: left: Type one scan head; right: Type two scan head.

Sample holder 
guide bars

Approach motor with sample holder fixing magnet

Sample holder 
point supports

Tip holder with clamp
15
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The Probe Status light
Indicates the status of the Z-Feedback loop. It can indicate the following 
statuses:

red The scanner is in its upper limit position. This occurs 
when the tip-sample interaction is stronger than the 
set point for some time. There is danger of damaging 
the tip due to too high an interaction.

orange/yellow The scanner is in its lower limit position. This occurs 
when the tip-sample interaction is weaker than the set 
point for some time. The tip is probably not in contact 
with the sample surface.

green The scanner is not in a limit position, and the feed-
back loop can measure the sample surface.

The easyScan 2 Controller

Video Out
connector
(optional)

Probe Status light

Scan head 
cable connector

Video In
connector
(optional)

Signal Out 
connector
(optional)

Signal In 
connector
(optional)

Scan Head lights
Module lights

Power
switch

USB active
light

Mains power
connector

USB power
light

USB input
(from PC)

Controller
Serial number

USB outputs
(to dongle)

S/N: 23-05-001

USB 

Mains 

Probe 



CONNECTORS, INDICATORS AND CONTROLS
blinking green The feedback loop has been turned off in the software.

The Scan Head lights
Indicate the scan head type that is connected to the instrument. The Scan 
head lights blink when no scan head can be detected, or when the Control-
ler has not been initialised yet.

The Module lights
Indicate the modules that are built in into the Controller. The module 
lights blink when the Controller has not been initialised yet. During initial-
isation, the Module lights are turned on one after the other.
17
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Installing the easyScan 2 STM

The following sections describe the installation of the easyScan 2 STM.

IMPORTANT
To enable measurements of atomic resolution to be made the following pre-
cautions must be taken to keep equipment dust and grease free:

• Never let your fingers touch either the wire for tips (figure Contents of the 
STM Tool set (p.14), 6), the sample (Contents of the STM Tool set, 7) nor 
the parts of the STM scan head indicated in figure Parts of the scan head.

• Only touch the sample holder (Contents of the STM Tool set, 5) at the 
black plastic end.

Installing the Hardware

IMPORTANT

• Ascertain that the mains connection is protected against excess voltage 
surges.

• Place the instrument on a stable support in a location that has a low level 
of building vibrations, acoustic noise, electrical fields and air currents.

If the vibration isolation of your table is insufficient for your measurement 
purposes, an optional active vibration isolation table is available.

Installing the Basic STM Package
- Put the STM scan head (Components (p.13), 4) onto the vibration isola-

tion platform (Components, 11).

- Fix the scan head cable under the strain relief clip on the platform.

- Connect the STM scan head to the Controller (Components, 1).

- Connect the USB cable (Components, 2) to a free USB port on your com-
puter, but do not connect it to the easyScan 2 Controller yet. If you have 



INSTALLING THE HARDWARE
inadvertently done this anyway, continue with section Installing the Soft-
ware (p.20).

Installing the Signal Module: S
- Connect the Signal Module: S (Components, 12) to the Signal Out con-

nector on the Controller (The easyScan 2 Controller (p.16)).

In case of an upgrade, the Controller must be sent in to your local Nanosurf
distributor for mounting the Signal Module: S electronics in the Controller.

Installing the Signal Module: A
- Connect one Signal Module cable (Components, 14) to the Signal Out 

connector on the Controller and to the Output connector on the Con-
nector box.

- Connect the other Signal Module cable to the Signal In connector on the 
Controller and to the Input connector on the Signal Module: A.

In case of an upgrade, the Controller must be sent in to your local Nanosurf
distributor for mounting/replacing the Signal Module: A electronics in the 
Controller.

Turning on the Controller
- Connect the easyScan 2 Controller (Components, 1) to the mains using 

easyScan 2 STM system
19
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the mains cable (Components, 3) and turn it on.

First all status light on top of the Controller shortly light up. Then the Scan 
Head lights, and the lights of the detected modules will start blinking, and 
all other status lights turn off. The status lights remain blinking until the 
Controller is initialised by starting the easyScan 2 software.

Storing the Instrument

If you have to send in the instrument, transport it or if you are not using it 
for some time, please pack it in the shipping package or the instrument case, 
so that the instrument is protected from dust.

- Turn off the instrument as described in section Turning off the instrument
(p.49), and remove all cables.

- Remove the sample and sample holder. The tip can be left in the scanner.

- Store the sample holder in its container.

- Pack all components as shown in figure Packing.

IMPORTANT
Always put the instrument in the original Nanosurf shipping box or Instru-
ment Case.

Installing the Software

- Check that the computer on which you want to install the software fulfils 
the requirements listed in section Computer requirements (p.11).

- Disconnect the USB cable from the easyScan 2 controller.

- If you are running Windows Vista, disconnect the computer from the 
internet.

This way, Windows Vista can not automatically look for the most (un)suit-
able driver on the Internet.



INSTALLING THE SOFTWARE
- Turn on the computer and start Windows.

IMPORTANT

• Log on to your computer as an administrator.

• Do not run any other program when you are installing the scan software.

- Insert the easyScan 2 Installation CD into the CD drive of the computer.

The setup program should start automatically. If this does not happen, pro-
ceed as follows:

- Open the easyScan 2 Installation CD.

- Start the program ‘StartCDMenu.exe’.

Now continue the normal installation procedure.

- Click the ‘Full Installation of Nanosurf easyScan 2’ button.

Packing: The easyScan 2 STM system packed in the Instrument Case
21
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The installation program will now start installing all components of the 
Nanosurf easyScan 2 STM: The hardware drivers, the easyScan 2 software 
and DirectX 9.

In Windows Vista, a Dialog is displayed with the title “An unidentified 
program wants access to your computer”.

- Click the ‘Allow’-button.

- Follow the instructions given by the setup program.

Step 1 - Installation of hardware drivers
The Nanosurf hardware needs instrument drivers for the USB hub, the 
USB interface and the Video Frame grabber in the video module for the 
easyScan 2 AFM. These drivers are installed first.

Connecting the controller to the computer

- Turn on the controller

If you do not turn on the controller, the driver for the Video module 2 will 
not be installed.

- Connect the USB cable to the easyScan 2 controller.

The red USB power light on the controller now lights up on controllers 
with normal speed USB (1.1). The red USB power light on the controller 
starts to blink on controllers with high speed USB (2.0). 

If you have connected a high speed USB controller to a normal speed USB 
connector, the computer will display a message that you have connected a 
normal speed device to a high speed connection. 

- Install the system a computer with high speed USB support if this mes-
sage is displayed and you are using the video module version 2.

The image resolution of the video image will be greatly reduced if you do 
not use video module version 2 with a high speed USB connection.

Installing the drivers (Windows Vista)
When the controller is connected to the computer, windows automatically 
detects that new devices have been connected to it. On some computers, 
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the detection process takes some time (20 seconds or more), please be 
patient. 

If you have already installed the control software for a Nanosurf Scanning 
Probe Microscope on this computer, it is possible that nothing will happen, 
because the drivers are installed already. If this is the case, click OK in the 
Step 1 Dialog.

Once the computer has detected the new devices, it will display the ‘Found 
New Hardware’ Dialog.

- Click on the text ‘Found New Hardware’ in the Windows task bar if the 
‘Found New Hardware’ dialog is not displayed.

The ‘Found New Hardware ‘dialog, asks you when to install the drivers for 
all the new devices that if found:

- Select the entry ‘Locate and install driver software (recommended)’.

The ‘Windows needs your permission to continue.’ Dialog is now dis-
played.

- Click the ‘Continue’-button

The following devices can be installed, depending on the configuration of 
your controller:

• USB <-> serial interface

• USB Serial Port

• Unknown device (Video Module)

- Look up and carry out the installation instructions for each of these 
devices given in the sections below.

If something went wrong during driver installation, continue the setup nor-
mally. When the setup is finished, refer to section Driver problems (p.66).

- Click OK in the ‘Step 1’ dialog.

USB <-> serial interface

When the operating system finds the ‘USB <-> serial interface’, it asks what 
to do:
23
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- Click the ‘Next’ button or the default choice in all other dialogs.

The driver ‘USB High Speed Serial Converter’ is now installed.

USB Serial Port

After the High Speed Serial Converter is installed, the operating system 
finds the ‘USB Serial Port’, it asks what to do:

- Click the ‘Next’ button or the default choice in all other dialogs.

Click the default choice in all other dialogs.The USB Serial Port is now 
installed.

Unknown device (Video Module)

The USB Video Adapter driver is only installed if the Controller contains 
a Video Module. The installation procedure depends on the version of the 
video module. 

Video Module version 1:

When the operating system finds an ‘Unknown Device’, it asks what to do 
to:

- Select 'Browse my computer for driver software (advanced)'

A dialog called ‘Browse for driver software on your computer’ now opens. 

- Select the path of the installation CD (usually ‘D\’).

- Check the box ‘Include subfolders’.

Windows Security will show the dialog box ‘Windows can’t verify the pub-
lisher of this driver software’.

- Select ‘Install this driver software anyway’.

Windows will not install the driver, and notify that the ‘USB Video 
Adapter’ device has been successfully installed.

IMPORTANT
Repeat Step 1 for all USB ports of the PC, in order to ensure that the USB 
Video Adapter works when connecting the Controller to a different PC 
USB port.

Video Module version 2:
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When the operating system finds an ‘Unknown Device’, it asks what to do:

- Select 'Browse my computer for driver software (advanced)'

A dialog called ‘Browse for driver software on your computer’ now opens. 

- Select the path of the installation CD (usually ‘D\’).

- Check the box ‘Include subfolders’.

The installation of the driver will now be finished. After all drivers have 
been installed, Found New Hardware may notify you that one ‘Device 
driver software was not successfully installed’. This is not a problem, it will 
be remedied by the next step of the installation, step 1A. This step com-
pletes the installation of the Video Module version 2.

- Click the ‘OK’ button.

When the installation of the Video Module version 2 is completed, the 
computer must reboot. After rebooting, the drivers ‘USB Compound 
device’, ‘USB 2.’ A/V Converter’ and ‘USB EMP Audio device’ will be 
installed.

Once the computer has rebooted:

- Start the Setup program again (by double-clicking the installation CD in 
windows Explorer)

- Click the ‘Full Installation of Nanosurf easyScan 2’ button.

The installation procedure should now continue with STEP 2. If the instal-
lation procedure does not continue, perhaps you have not waited for the 
message ‘ready to use’, or something else went wrong during the installation 
of the drivers for the video module.

Installing the drivers (Windows XP, 2000)
When the controller is connected to the computer, windows automatically 
detects that new devices have been connected to it. On some computers, 
the detection process takes some time (20 seconds or more), please be 
patient. 

If you have already installed the control software for a Nanosurf Scanning 
Probe Microscope on this computer, it is possible that nothing will happen, 
25
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because the drivers are installed already. If this is the case, click OK in the 
Step 1 Dialog.

Once the computer has detected the new devices, it will display the Dialog 
‘Found New Hardware’.

The following devices can be installed, depending on the configuration of 
your controller:

• Standard-USB-hub

• USB <-> serial interface

• USB Serial Port

• USB Device (Video Module)

- Look up and carry out the installation instructions for each of these 
devices given in the sections below.

If something went wrong during driver installation, continue the setup nor-
mally. When the setup is finished, refer to section Driver problems (p.66).

- Click OK in the ‘Step 1’ dialog.

Standard-USB-hub

The operating system should first find the ‘Standard-USB-hub’, and install 
its driver. The installation order of the other drivers may vary.

USB <-> serial interface

When the operating system finds the ‘USB <-> serial interface’, it asks what 
to do:

- Select 'No not this time'

- Click ‘Next’

- Select ‘Install the software automatically (Recommended)’

- Click ‘Next’

The message ‘Installed USB <-> Serial’ is not displayed

- Click ‘Finish’

The driver ‘USB High Speed Serial Converter’ is now installed.
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USB Serial Port

After the High Speed Serial Converter is installed, the operating system 
finds the ‘USB Serial Port’, it asks what to do:

- Select 'No not this time'

- Click ‘Next’

- Select ‘Install the software automatically (Recommended)’

- Click ‘Next’

The message ‘Installed USB <-> Serial’ is not displayed

- Click ‘Finish’

The driver ‘USB Serial Port’ is now installed.

USB Device (USB Video Adapter)

The USB Video Adapter driver is only installed if the Controller contains 
a Video Module. The installation procedure depends on the version of the 
video module. 

Video Module version 1:

When the operating system finds the ‘USB Device’, it asks what to do to 
install the ‘USB Video Adapter’:

- Select 'No not this time'

- Install the software automatically (Recommended)

During installation of the video adapter under windows XP, windows may 
notify you that the driver is not digitally signed. If this happens:

- Click ‘Continue installation’.

- Click the default choice in all other dialogs.

IMPORTANT
Repeat Step 1 for all USB ports of the PC, in order to ensure that the USB 
Video Adapter works when connecting the Controller to a different PC 
USB port.
27
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Video Module version 2:

- Select 'No not this time'

- Click ‘Next’.

- Select 'Install the software automatically (Recommended)’

- Click ‘Next’.

The message ‘Installed USB 2.0 A/V Converter is now displayed

- Click the ‘Finish’ button.

After the installation of the Drivers has finished, a step 1A may follow, that 
completes the installation of the Video Module version 2.

- Click the ‘OK’ button.

When the installation of the Video Module version 2 is completed, the 
computer must reboot. After rebooting, windows shows the notifications:

• Found New Hardware USB Device

• Found New Hardware USB EMP Audio Device

• Your New Hardware is now ready to use.

- Wait until the ‘ready to use’ message is displayed

The drivers ‘USB Compound device’, ‘USB 2.0 A/V Converter’ and ‘USB 
EMP Audio device’ are now installed.

- Start the Setup program again (by double-clicking the installation CD in 
windows Explorer)

- Click the ‘Full Installation of Nanosurf easyScan 2’ button.

The installation procedure should now continue with STEP 2. If the instal-
lation procedure does not continue, perhaps you have not waited for the 
message ‘ready to use’, or something else went wrong during the installation 
of the drivers for the video module.

Step 2 - Installation of the easyScan 2 software
- Click the default choice in all dialogs.



INSTALLING THE SOFTWARE
The setup program will ask for the directory in which the easyScan 2 soft-
ware is to be installed.

- Install the software in the proposed directory.

IMPORTANT
The easyScan 2 Installation CD contains calibration information (.hed 
files) specific to your instrument, therefore you should keep (a backup copy 
of ) the CD delivered with the instrument.

Step 3 - Installation of DirectX 9
The easyScan 2 software needs DirectX 9 or newer for correct operation.

Click the default choice in all dialogs.

- After installing DirectX 9, the computer may have to re-boot.

Installing the software on different computers
You can install the easyScan 2 software on a different computer than the 
one that controls the measurement, for example for running the microscope 
simulation, or for off-line data analysis. Please note:

• In order to use the Controller, the hardware drivers and DirectX 9 must 
be installed on the computer to which it is connected.

• The controller and its drivers must be installed when installing the Nano-
surf Scripting Interface.

-
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Preparing for Measurement

This chapter describes actions that you perform on a day-to-day basis as a 
preparation for your measurements, when the instrument has already been 
set up according to the instructions in chapter Installing the easyScan 2 STM
(p.18). These steps are preparing and installing the STM tip, selecting a 
sample stage, and preparing the sample.

Initialising the Controller

- Check that the easyScan 2 Controller is connected to the mains power 
and to the USB port of the control computer.

- Turn on the power.

First all status light on top of the Controller shortly light up. Then the Scan 
Head lights and the lights of the detected modules will start blinking, and 
all other status lights turn off.

- Start the easyScan 2 software on the control computer.

The main program window appears, and all status lights are turned off. 
Now a Message ‘Controller Startup in progress’ is displayed in the software, 
and the module status lights start lighting up one after the other. When 
initialisation is completed, a Message ‘Starting System’ is shortly displayed 
in the software and the Probe Status light (p.16), Scan Head status light of 
the detected scan head and modules will light up. If no scan head is 
detected, both scan head status lights blink.

Preparing and installing the STM tip

The STM tip can be prepared and installed by yourself. This is the most 
difficult part of your preparations. It usually needs patience and some prac-
tise to get the first good tip. Only an accurately cut tip enables optimal 
measurements. Therefore, cutting and installing should be carried out with 
great care. On delivery, the tip with which the STM was calibrated in the 
factory is installed in the head. This tip should give atomic resolution, so 



PREPARING AND INSTALLING THE STM TIP
you may wish to try to use this tip before preparing your own. Before cut-
ting the tip:

- Clean the cutting part of the wire cutters (figure Contents of the STM Tool 
set (p.14), 1), the Flat nose pliers (Contents of the STM Tool set, 2) and the 
pointed tweezers (Contents of the STM Tool set, 3) with ethanol.

- Only touch the Pt/Ir wire (Contents of the STM Tool set, 6) with these 
tools.

- Remove the old tip from the instrument using the pointed tweezers.

- If the tip wire is still long enough, you may try to cut the same wire again, 
otherwise take the Pt/Ir wire. To prepare the tip:

- Hold the end of the wire firmly with the pliers.

- Holding the wire with the pliers, move the cutters at a length of approx-
imately 4mm, as obliquely as possible (figure Cutting the STM tip).

- Close the cutters until you can feel the wire, but do not cut the wire.

- Pull in the direction shown in the figure. The tip needs to be torn off 
rather than cleanly cut through, in order to get the required sharp tip.

Cutting the STM tip

Flat nose 
pliers

wire cutter

pulling
direction

Pt/Ir wire

~4mm
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- Use the pointed tweezers to hold the tip wire with just behind the tip.

- Release the flat pliers.

IMPORTANT

• Never touch the end of the tip with anything.

• Ensure that the tip wire is straight.

• Do not twist the tip clamp in the open part of the scan head nor lift it too 
high.

The procedure for mounting the tip under the tip clamp depends on the 
type of clamp on your scan head:

Single clamp
Proceed as is illustrated in figure Mounting the tip under the single clamp:

1. Put the tip wire on the tip holder parallel to the groove in the tip holder, 
so that it crosses below the tip clamp (figure a).

2. Move the tip wire sideways until it is in the groove in the tip holder 

STM tip: Scanning Electron Microscope images of an STM tip

Mounting the tip under the single clamp

a) b)

2.1.



INSTALLING THE SAMPLE
(Figure b).

The freshly cut tip should be securely held under the clamp and extend 
about 2-3mm beyond the tip holder. The tip is now installed.

Double clamp
Always use the following procedure for mounting the tip under the double 
clamp (figure Mounting the tip under the double clamp). Using a different 
procedure may cause a gradual deterioration of the measurement quality 
due to loosening of the clamp.

1. Hold the tip wire at a slight angle, and move it along the groove against 
the first clamp, so that the end of the wire is under the clamp (figure a).

2. Lower the wire so that it lifts the first clamp (figure b).

3. Push the wire in, until it touches the second clamp.

4. Lift the wire.

5. Push the end of the wire below the second clamp.

6. Lower the wire so that it lifts the second clamp (figure c).

7. Push the wire under the second clamp.

The freshly cut tip should be securely held under the clamp and extend 
about 2-3mm beyond the tip holder. The tip is now installed.

Installing the sample

Preparing the sample

IMPORTANT
Never touch the sample's surface once it is prepared.

Mounting the tip under the double clamp 

1.

a)

2.

3.

4.

b)

5.

6.7.
c)
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The STM can only examine electrically conductive materials. Nevertheless 
the choice of material is rather small because the surface of the sample must 
not oxidise, be totally clean and mirror-like to obtain useful results. Because 
of this some of the samples need special preparation.

Gold thin film
Cleaning the sample is neither possible nor necessary. Never touch the sam-
ple with your fingers or put it upside down anywhere, this will only make 
it unusable faster.

Graphite
The surface of the graphite sample can be cleaned when it is very dirty or 
uneven. Due to the layered structure of graphite this can easily be done 
using a piece of adhesive tape (figure Cleaving graphite):

- Put the sample on the table using the pair of tweezers.

- Stick a piece of adhesive tape gently to the graphite and then pull it off 
again: The topmost layer of the sample should stick to the tape.

- Remove any loose flakes with the pa§ir of tweezers.

The graphite sample is now ready for use and may not be touched.

Other samples
You can mount other samples on the spare disc shaped sample supports 
(figure Contents of the STM Tool set (p.14), 7). The supports are made of a 
magnetic steel that is galvanically coated with nickel. Use conducting glue 

Cleaving graphite



INSTALLING THE SAMPLE
to attach the sample to the sample support. Contact your Nanosurf distrib-
utor if you have difficulties obtaining such a glue, 

Installing the sample
- Unpack the sample holder (figure Contents of the STM Tool set (p.14), 5) 

touching only its black plastic handle.

IMPORTANT
Always store the sample holder in its package, in order to prevent corrosion 
(chapter Maintenance (p.63)).

- Put the prepared sample onto the magnetic end of the sample holder 
using a pair of tweezers (Figure Putting the sample on the holder):

- Place the sample holder carefully in the scan head so that it doesn’t touch 
the tip, and the sample is not pulled from the sample holder by the mag-
net that holds the sample holder in place (figure Placing the sample holder 
in the scan head).

- Put the sample holder down on to the sample holder guide bars first and 
release it gently on to the approach motor’s support.

Putting the sample on the holder
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Placing the sample holder in the scan head



RUNNING THE MICROSCOPE SIMULATION
First Measurements

In this chapter, step by step instructions are given as to how to operate the 
microscope and make a simple measurement. More detailed explanations 
of the software and the system are given in the Software Reference manual.

Running the microscope simulation

You can start the easyScan 2 software without having the microscope con-
nected to your computer in order to explore the easyScan 2 system (meas-
urements and software) without danger of damaging the instrument or the 
cantilever. In the simulation mode, most functions of the real microscope 
are emulated. The sample is replaced by a mathematical description of a 
surface.

When you start the easyScan 2 software when no microscope is connected 
to your PC, the following dialog appears:

- Click ‘OK’.

The status bar will now display the text ‘Simulation’.

You can also switch to the simulation mode with the microscope connected:

- Select the menu entry ‘Options>Simulate Microscope’.

A check will now be displayed in front of the menu entry.

To exit the Microscope simulation mode:

- Select the menu entry ‘Options>Simulate Microscope’ again.

The check in front of the menu entry is now removed, and the status bar 
will now display the text ‘Online’.
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Preparing the instrument

Prepare the instrument as follows (Refer to chapter Preparing for Measure-
ment (p.30) for more detailed instructions):

- Prepare and install a Pt/Ir tip.

- Install the HOPG sample.

To make sure that the configuration is correct, do the following:

- Open the User interface dialog via the menu ‘Options/Config User Inter-
face...’.

- Select the ‘Easy level’ user interface mode.

- Open the menu item ‘File>Parameters>Load...’, and load the file 
‘Default_EZ2-STM.par’ from the directory with default easyScan 2 con-
figurations. Usually this is ‘C:\Program Files\Nanosurf\Nanosurf easy-
Scan 2\Config’.

Entering values in the control panels
To change a parameter in any panel, use on of the following methods:

• Activate the parameter by clicking it with the mouse pointer, or by select-
ing it with the Tab key.

• The value of an activated parameter can be increased and decreased using 
the up and down arrow keys on the keyboard. The new value is automat-
ically used after one second.

• The value of a numerical parameter can also be increased and decreased 
by clicking the arrow buttons  with the mouse pointer. The new value 
is automatically used after one second.

• The value of an active numerical parameter can also be entered using the 
keyboard.  
The entered value is used on pressing the ‘Enter’ or ‘Return’ key, or by 
activating another input.  
The entered value is discarded on pressing the ‘Esc’ key. 



APPROACHING THE SAMPLE TO THE TIP
Type the corresponding character to change the unit prefix: 

For example, if the basic unit is Volts, type ‘m’ to change to millivolts, 
type the space bar for volts, type ‘u’ for microvolts.

• The selection of a drop-down menu (e.g.: ) can be 
changed using the mouse or the up and down arrow keys on the key-
board.

Sometimes the program will change an entered parameter value to a slightly 
different value. This happens when the desired value is outside the range 
that the easyScan 2 Controller can handle, for example due to the resolu-
tion limits or timing limits. The desired value is automatically changed to 
the nearest possible value.

Approaching the sample to the tip

To start measuring, the sample must be very close to the tip to enable a 
tunneling current to flow. Approaching the sample without touching the 
tip is a delicate operation carried out in three steps. Manual coarse 
approach, manual approach using the approach stage, and the automatic 
final approach. The colour of the Probe Status light on the Controller shows 
the status of the approach:

orange Normal state during approach, the Z-scanner is fully 
extended toward the sample.

red The approach has gone too far, the tip was driven into 
the sample, and the Z-scanner is fully retracted away 
from the sample. In this case, the tip is probably dam-

prefix keyboard key prefix keyboard key
femto f no prefix space bar
pico p kilo k
nano n mega shift - M
micro u giga shift - G
milli m tera shift - T

Unit prefixes with corresponding character
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aged, so you will have to start over again with prepar-
ing a new tip.

green The approach is finished, the Z-scanner is within the 
measuring range, tunneling current should be flowing.

1. Manual Coarse approach
- Push the sample holder carefully to within 1mm distance of the tip.

- If the tip is pointing toward a rough area of the sample, try turning the 
sample holder around its axis so that the tip points towards a flat, mirror-
like area of the sample.

- Put the magnifying cover (Components (p.13), 5) over the scan head with-
out touching the sample holder.

- Place the magnifier so, that you can see the mirror image of the tip in the 
sample.

The cover reduces air flow around the scan head and reduces thermal drift 
in measurements at atomic scale.

Manual Coarse approach



APPROACHING THE SAMPLE TO THE TIP
2. Manual approach using the approach motor
The approach motor is operated using the Approach Panel in the Position-
ing window. To open this window:

- Click the Positioning icon  in the Navigator.

- Watch the distance between tip and sample with help of the magnifier. 

Now click  in the Approach Panel to move the sample towards 
the tip to a distance of a fraction of a millimetre.

You should only just be able to see the gap between the tip and its mirror 
image (figure Tip-sample position). The smallest visible gap depends on the 
observation angle of the magnifier and the lighting of the sample.

If you can not see the motor has moving, clean the sample holder guide bars 
and the surfaces of the approach motor following the procedure described 
in chapter Maintenance (p.63).

3. Automatic final approach
In the last step, the tip approaches the sample, until the set point is reached. 
First check that the set point and the feedback speed are set properly:

- Click  in the Navigator to open the Z-Controller Panel.

- Set ‘Set point’ (tunneling current) to 1.00nA.

Tip-sample position: Position at the end of the Manual approach with the approach motor.
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- Set Loop gain (the speed of the feedback loop) to 1000 for normal heads, 
or to 200 for LC heads.

- Set ‘Tip voltage’ (tip-sample-voltage) to 50mV.

Now that the feedback settings are correct, the automatic final approach 
can be started:

- Click  in the Approach Panel.

The sample holder is now stepped towards the tip with the approach motor. 
After each step, the Z-scanner is fully retracted from the sample, and 
released to move towards the sample. The approach is finished if the current 
determined by Set point is detected before reaching the maximum exten-
sion of the Z-scanner, otherwise the approach motor will continue with the 
next step. Due to the motion of the Z-scanner, the Probe Status light will 
blink red-green-orange-red-green-etc.

If the approach was finished successfully, the probe status changes from 
blinking to green and the message box ‘Approach done’ appears.

- Click the ‘OK’-button.

If the status light change to red instead of green, or if the approach has not 
finished after 10 - 20s, try to decrease the tip-sample distance a little more 
using manual operation of the approach motor. If the automatic final 
approach never works, refer to chapter Problems and Solutions (p.65) for the 
next steps to take.



STARTING A MEASUREMENT
Starting a measurement

Now that the tunneling current defined by Set point is flowing between tip 
and sample you can start measuring:

- Click  to open the Imaging window.

The STM has already started imaging the sample.

If the preparation of tip and sample and the approach were successful, 
images of the measurement will show a more or less straight line in the Line 
graph (figure Starting image, left) and a plane in the Color map. Watch the 
displays for a while until the Color map-image has been drawn about three 
times.

A ‘nervous’ line in the Line graph indicates a bad tunneling contact (figure 
Starting image, right). Usually this is caused by the tip being too blunt or 
instable. This means that you should stop measuring and cut a new tip:

- Click  and follow the instructions of the chapter Problems and Solu-
tions (p.65).

If the line in the Line graph is calm and reproduces consistently, you can 
continue with the next section.

Achieving atomic resolution

You prepared your measurement so that the Topography in the Line graph 
is reproducing stably. Now the scan range has to be decreased in order to 
observe the atomic structure.

Starting image: left: a good Line graph; right: a ‘nervous’ Line graph.
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Reminder: Measurements on the nanometer scale are very sensitive. Direct 
light, fast movements causing air flow and temperature variations near the 
scan head can influence and disturb the measurement. It is best to let a 
promising measurement run for some time to let it stabilize thermally.

To decrease the Imaging area:

- Click the Color map chart to make it active.

A gray square is now drawn around the Color map chart.

- Click .

The mouse pointer becomes a pen when moving over the selected chart and 
and the Tool Results Panel opens.

- Move the mouse cursor to a ‘flat’ region (similar color) in the Color map 
and click on it.

The software will now draw a square that indicates of the new scan range. 
The size of the new scan range is displayed in the Tool Results Panel. If no 
flat region is available, refer to chapter Improving measurement quality
(p.50) for further instructions.

- Change the size of the new scan range to about 30-50nm by clicking and 
dragging a corner of the square with the mouse cursor.

- Double click the chart when the scan new area is set as you want it. You 

 



ACHIEVING ATOMIC RESOLUTION
can abort the zoom function by clicking with the right mouse button.

The imaging settings are now set in such a manner that the new measure-
ment will correspond to the area that was indicated by the square.

The image size should be decreased even further, considering that one 
nanometer is the diameter of between four and eight atoms. Atomic 
arrangements can normally be made out at an Image size of about 4nm:

- Set the Image size in the Imaging panel to 4nm.

- Some parts of the scan head react to the slightest temperature changes. As 
these thermal ‘movements’ influence the measurements on the nanometer 
scale, the sample has to be scanned as fast as possible.

- Set the Time/Line in the Imaging Panel to 0.06s for atomic resolution.

- You may also try to decrease noise by decreasing the Loop gain of Z-
Controller.

- Try varying these parameters to get a nice image of the graphite surface.

Good images of a successful measurement
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The graphite surface

In a good color map chart of graphite you will see a pattern consisting of 
white, grey and black spots. It looks like a three dimensional image of balls 
lying next to each other, but be careful: these are not the single atoms!

To interpret the image correctly you must first be aware that bright spots 
show high points and dark spots low ones.

In the lattice model of graphite one can see that there are two different 
positions of the carbon atoms in the graphite crystal lattice: One with a 
neighbouring atom in the plane below (grey) and one without a neighbour 
in the lattice below (white). As a consequence, the electrical conductivity of 
the graphite surface varies locally slightly so that the atoms without neigh-
bours appear higher than the others.

This also causes the lattice constant between the bright ‘hills’ to have the 
higher than normal value of 0.25nm.

Storing the measurement

When you are satisfied with your image and would like to keep it, you can 
take a snapshot of it by clicking the  button. The behaviour of this 
button depends on whether a measurement is in progress or not.

Graphite surface: left: measurement; right: lattice model

0.25nm
0.14nm

0.34nm



FINISHING
When a measurement is in progress, and  is activated, a copy of the 
measurement is made to a measurement document after the measurement 
is finished.

When the measurement is not in progress, a copy is made immediately.

If you would like to take the snapshot of the measurement as it appears 
during the measurement without waiting to finish:

- Click  to stop scanning.

- Generate a snapshot by clicking .

If you want to save the measurement document to your hard disk drive, for 
example for loading it to Nanosurf Report:

- Activate the measurement document by clicking in its window, or by 
selecting it in the ‘Windows’ menu.

- Select the menu ‘File>Save as...’. Select the folder and file name where you 
would like to store the measurement.

The stored measurements can now be loaded with the easyScan 2 software 
and the Nanosurf Report software for later viewing, analysis and printing 
(see also Software Reference manual).

Finishing

Once you are done measuring:

- Click  to stop measuring.

- Retract the sample holder first by using  then .

- Remove the magnifying cover from the scan head.

- Remove the sample holder with one hand.

- Remove the sample from the sample holder and store it in its case with 
the other hand.

- Store the sample holder in its container.
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Measuring Gold

It is more difficult to obtain good images of a gold. Atomic structures are 
difficult to observe because the electrons on the surface are much more 
homogeneously distributed than in graphite. But with some training the 
mono-atomic gold steps can be observed.

Due to the fact that the gold sample cannot be cleaned by simple means it 
is possible that with time contaminants may prevent you from obtaining 
good results.

Tip
Before you do any experiments with the gold sample it is necessary to prac-
tise on the graphite sample. You should also test the quality of your tip using 
the graphite sample.

Proceed as you did with the graphite sample, but there are two exceptions 
to note:

- Set the Tip voltage in the Z-Controller panel to 0.5V.

- Set the Time/Line in the Imaging Panel to 0.3s.

If you do not get stably reproduced scan lines you should look for another 
clean measuring spot.

- First try with  followed by . If that does not change 



CREATING A REPORT
much retract the sample holder and rotate it a little by hand. Repeat the 
approach.

- If the image reproduces stably, select a Image size between 200 and 
300nm.

Evaluate your measurements in the same way as you did with the graphite 
images, zoom, measure, save etc.

Creating a report

The optional Nanosurf Report software can be used for evaluating the 
measurement, and creating visually appealing reports. Here, we will just 
start the software and create a basic report.

- Click  in the Navigator.

The Report software will now start, open the currently selected measure-
ment in the report software, and evaluate it with the default template.

For an in depth introduction to the Nanosurf Report software, refer to the 
Introduction section of the Nanosurf Report online help.

Turning off the instrument

- Follow the instructions from section Finishing (p.47).

- Verify that you have saved all measurements that you would like to keep.

- Exit the easyScan 2 software after having stored all desired measurement 
documents. If you exit the program whilst having some unsaved measure-
ments, you will be asked to save them now.

- Turn off the power switch.

If you perform measurements regularly leave the instrument with the Mag-
nifying cover over the scan head to protect it against dust.

If you do not operate the instrument for several weeks, store the instrument 
as is described in section Storing the Instrument (p.20).
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Improving measurement quality

Judging and improving tip quality

From the quality of the measured images the quality of the tip and conse-
quently that of the tunneling contact can be observed. A good tunneling 
contact is necessary for high quality images of atomic resolution.

If during a good measurement the image quality diminished dramatically, 
the tip has most probably picked up some particles or you are near a step in 
the surface.

- Continue measuring for a while (4-5 images); the tip may eventually lose 
the picked up material again.

If this does not help, try to induce changes at the tip’s end using one of the 
following procedures:

• While measuring increase the gap voltage in the ‘Feedback Panel’ to 2V 
then reduce it to the old value again. 

• Increase the tunneling current to 20nA for a short time then reduce it to 
its old value again.

•  Retract the sample, then perform a new approach.



JUDGING AND IMPROVING TIP QUALITY
If no improvement can be seen after going through these procedures, you 
have to prepare a new tip:

- Follow the instructions from section Finishing (p.47).

- Follow the instructions in section Preparing and installing the STM tip
(p.30).

Examples of images made with unusable tips
Prepare a new tip when your image looks like one of the examples below.

The color map image consists of uncorrelated lines.

The image is ‘smeared out’ on one border (here on the left border).
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Decreasing thermal drift

Temperature variations cause so-called ‘thermal drift’. This will cause 
images to be distorted. This effect can be observed when e.g. the upward 
scan is very different to the downward scan showing two differently dis-
torted lattices.

Each image looks different.

The scan lines in Line graph are unstable and the image in the Color map is blurred.



REMOVING INTERFERING SIGNALS
Thermal drift is very clearly perceptible on an atomic scale. Variations of 
0.1°C already cause variations in the length of e.g. the sample holder (steel) 
of several nanometers.

To decrease thermal drift, keep the measurement running for some time to 
let the system stabilize (up to about one hour).

Removing interfering signals

Interfering signals can be recognised because they have a fixed frequency, 
usually a multiple of the local mains frequency (50 or 60 Hz) throughout 
the image. Thus, they are manifested by straight lines, that run throughout 
the image.

Possible interference sources are:

• Mechanical vibrations from machines or heavy transformers in the envi-
ronment (e.g. pumps).

• Electrical interference (in the electronics, or in electrical forces in the tip-
sample interaction).

Mechanical vibrations
To find out if the interference is due to mechanical vibrations:

- Measure the frequency of the vibrations.

Consecutive upward and downward scan showing thermal drift.
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These vibrations have a frequency that is (a multiple of ) the rotation fre-
quency of the source. This frequency is usually not a multiple of the local 
mains frequency, and may change slightly over time. Try the following to 
find out if the interfering signal is due to mechanical vibrations:

- If possible, turn off all rotating machines (i.e. pumps) in the room.

- Change the vibration isolation by putting the Scan head directly on the 
table, instead of on the Sample stage.

To reduce the influence of these vibrations, either improve the isolation of 
these machines, or improve the isolation of the instrument by using a vibra-
tion isolation table (e.g. the optional TS-150 active vibration isolation table 
option).

Electrical interference
Electrical interference may be caused by interference in the electronics, or 
by electrostatic forces acting between the tip and the sample. Try the fol-
lowing in order to reduce the influence of electrical interference:

- Connect the instrument to the mains power supply using sockets with 
line filters and surge protection.

- Remove interfering electromagnetic field sources, such cathode ray tube 
displays, loudspeakers,...

Adjusting the measurement plane

Ideally, the plane of the measurement and the sample surface lie in the XY-
plane of the scanner. But mostly the sample plane is tilted with respect to 
that ideal plane, as shown is figure Maladjusted slope. In this case, the sample 
cross section in the X* measurement direction, as shown in the Line graph 
window, has a certain slope. This slope depends on the direction of the X* 
direction and therefore on the rotation of the measurement, as shown in 
figure Slope.

The measurement plane should be parallel to the sample plane because:

• It is easier to see small details on the sample surface when the planes are 
parallel, especially when the Average, Plane fit or higher order filters can-



ADJUSTING THE MEASUREMENT PLANE
not be used because they would distort the image, 

• The Z-Controller functions more accurately, because it does not have to 
compensate for the sample slope.

Maladjusted slope: Measurement with improperly set X*-slope.

Slope: Sample’s and measurement orientation before slope adjustment

X
Y

Z, Z*

Scanner XY-plane

'X-Slope' angle

'Y-Slope' 
angle

'Rotation' 
 angle

Measurement plane

Image area
X*Y*
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The measurement plane should therefore be adjusted electronically using 
the parameters ‘X-Slope’ and ‘Y-Slope’. To find the correct values, use the 
following procedure:

- The slope correction is only available with the Standard level and the 
Advanced level user interface mode. Open the User interface dialog via 
the menu ‘Options/Config user interface, and select one of these modes.

- Measure the slope in the Line graph using the angle tool (see Software 
Reference). Use a single click to measure the angle relative to the X*-axis.

- Alter the value of ‘X-Slope’ in the Imaging options of the Imaging Panel 
until the X-axis of the scan line lies parallel to the X-axis of the sample.

- Set Rotation to 90° to scan along the Y-direction of the scanner.

- If the scan line is not horizontal, alter the value for ‘Y-slope’ until the Y-
axis of the scan lies parallel to the Y-axis of the sample.

- Reset ‘Rotation’ to 0°. The Line graph shows the X-slope again.

Charts after adjusting the slopes
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Measurement modes

The surface can be scanned in two different ways: in the Constant current 
and Constant height mode.

In the Constant current mode, the tunneling current is kept constant by the 
Z-Controller. The output of the Z-Controller thus corresponds to the 
height of a surface of constant tip current. This output is then recorded as 
a function of X and Y position, and is displayed as the Topography signal.

In the Constant height mode on the other hand, the tip does not follow a 
surface of constant tip current. Instead the variation of the tunneling cur-
rent is directly recorded as a function of the X and Y position in plane 
parallel to the sample surface.

The easyScan 2 STM is normally configured to measure in the Constant 
current mode. To switch to the Constant height mode, you could theoret-
ically just turn off the Z-Controller. However, several problems arise:

• The tip would crash into the slightest unevenness of the surface.

• The scan plane of the scanner must be very well adjusted to the plane of 
the sample.

• The thermal drift in the Z-Direction will cause the tip to rapidly move 
away from the sample, or even worse, to be pressed into it.

• These problems can for a large part be avoided by setting the Loop-gain 
to a very low value. Thus, the feedback loop can follow the slow move-
ment of the sample caused by thermal drift and the sample plane, but not 
the fast height changes due to the presence of the atoms.

To measure in Constant height mode:

- Find a flat area of the sample by imaging it in Constant current mode, 
and zoom in on this area.

- Open the User Interface configuration dialog using the menu 
‘Options>Config User Interface...’.

- Set the User Interface Mode to ‘Standard level’ or ‘Advanced level’.
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- Click  to open the Z-Controller Panel.

- Set I-Gain to 4.

- Set P-Gain to 0.

To visualize the current:

- Click on a Color map chart in the Imaging Window.

- Set the Input channel to ‘Tip Current’ in the chart bar.

The bar next to Color map should now display the text ‘Tip Current’ and 
have the units ‘pA’ or ‘nA’ instead of ‘nm’.
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The Signal Modules

The Signal Modules consist of both electronics modules that are built into 
the Controller and a break-out Connector that is externally attached to the 
Controller. The Signal Modules can be used for monitoring the signals 
from (Signal Module: S) and adding functionality to (Signal Module: A) 
the easyScan 2 system. The Signal Module: A includes all the monitoring 
functions of the Signal Module: S.

For information on installing the Signal Modules, refer to section Installing 
the Hardware (p.18).

Signal Module: S

The Signal Module: S can be used for monitoring signals from the STM 
with external instruments, such as Volt-meters, Oscilloscopes or Spectrum 
Analysers. The signals are available on nine BNC connectors that are 
labelled with their signal names. The signal names and their function are 
listed in the table Monitor Signals:

Signal name Function
X-Axis X-Position command of the Scanner. Is affected by Image 

X-Pos and the Imaging Area Rotation.
Y-Axis Y-Position command of the Scanner. Is affected by Image 

X-Pos and the Imaging Area Rotation.
Z-Axis Z-Position command of the Scanner. Is affected by the Z-

Controller output, Ref. Z-Plane, X- and Y-Slope.
Tip Voltage The voltage applied to the tip.
Approach The voltage ramp that drives the approach motor.
Excitation no signal (AFM only)
Deflection The tip current (see below)
Amplitude no signal (AFM only)
Phase no signal (AFM only)

Monitor Signals
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The calibration of the monitor signals can be found by looking up the sig-
nal calibration in the Scan Head Calibration Dialog, reached via the menu 
‘Options>Config Scan Head...’. The magnitude of the physical signal can 
be calculated from the Monitor Signal voltage using the formula:

The Tip Current signal depends both on the Tip voltage, and the tunneling 
current. The current can be calculated using the formula:

In addition to the monitor voltages, +15V and -15V voltage sources are 
available for driving small home-made electronics. The voltages are availa-
ble on a three-pole mini-DIN connector. The pin-out of this connector is 
shown in figure Voltage source connector.

Signal Module: A

The Signal Module: A can be used for adding functionality to the easyScan 
2 system in addition to the applications of the Signal Module: S. The sig-
nals are available on twenty-one BNC connectors that are labelled with 

Voltage source connector: as seen from outside.

PhysicalSignal Unit[ ] MonitorSignalVoltage
10 V[ ]

------------------------------------------------------------ Maximum Offset+⋅=

TipCurrent TipCurrentSignalVoltage TipVoltage–( )
10 V[ ]

------------------------------------------------------------------------------------------------------------- Maximum Offset+⋅=

2: GND

3: -15V

1: +15V
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their signal names. The signal names and their function are listed in the 
tables Monitor Signals (p.59) and Signal Module: A Signals:

Signal name Function
Sync An output that can be used to synchronise external equip-

ment with the Controller. This feature will be described in 
more detail in a future manual version (refer to the Nano-
surf Web site).

User 1 Output An analog output that can be used to drive external instru-
ments using the Controller. The User output can be used 
for special spectroscopy measurements.

User 2 Output An analog output that can be used to drive external instru-
ments using the Controller. The User output can be used 
for special spectroscopy measurements.

X-Axis Input The Input voltage is added to the X-Position command of 
the scanner.

Y-Axis Input The Input voltage is added to the Y-Position command of 
the scanner.

Z-Axis Input The Input voltage is added to the Z-Position command of 
the scanner. If the Z-Controller is turned on, it will try to 
compensate this voltage, as a result of which, the Input 
voltage will be added to the topography measurement.

Tip Voltage The input voltage is added to the Tip-voltage set in the 
software.

Excitation Inputno function (AFM only)
User 1 Input An analog input that can be used to record the signal from 

external instruments in Imaging and Spectroscopy meas-
urements.

User 2 Input An analog input that can be used to record the signal from 
external instruments in Imaging and Spectroscopy meas-
urements.

Signal Module: A Signals
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The sum of the modulation inputs and the output value (for example of X-
Axis) should not exceed the -10V - +10V range.

In addition, -15V and +15V voltage sources are available for driving small 
home-made electronics. The voltages are available on the same type of 
three-pole mini-DIN connector that is used in the Signal Module: S. The 
pin-out of this connector is shown in figure Voltage source connector (p.60).

Using the User Inputs and Outputs
The user Inputs and Outputs can be configured using the User Input/Out-
put section of the Operating Mode Panel. This Section is only available in 
the Advanced Level User Interface.

Aux 1 A connector that can be used for accessing signals that are 
not otherwise available. Contact your local distributor if 
you need to use this connector.

Aux 2 A connector that can be used for accessing signals that are 
not otherwise available. Contact your local distributor if 
you need to use this connector.

Signal name Function

Signal Module: A Signals
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Maintenance

To ensure the fault-free operation of the microscope the following instruc-
tions for maintenance have to be followed.

Scan head
It is very important to prevent the sample holder and the open part of the 
scanner from becoming dirty or damp.

Protecting the sample holder against corrosion
The approach motor will not run well if the sample holder is dirty or cor-
roded.

The sample holder is made of magnetic steel and therefore suffers from 
corrosion in a humid environment. To reduce corrosion and increase life 
expectancy, the sample holder must be stored in its container together with 
the moisture absorbing silica container. The container is waterproof but not 
airtight. The silica contains a blue indicator which turns pink when satu-
rated. To regenerate the silica:

- Heat the silica container at 100°C for at least two hours until it turns 
completely blue again.

Cleaning parts of the approach motor
If you have touched the metal part of the sample holder, or it has otherwise 
become dirty, or the approach motor does not move:

- Take a soft cloth, if necessary moistened with alcohol.

- Clean the holder by moving the cloth along the sample holder in the axial 
direction, do not move it around its circumference.

- Let the parts dry before operating the motor again.
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If the approach motor still does not move:

- Take a cotton swab, if necessary lightly moistened with alcohol.

- Clean the sample holder guide bars (figure Cleaning the sample holder 
guide bars).

- Clean the surfaces of the approach motor that touch the sample holder.

- Clean the tip holder (remove the tip when doing this).

- Let the parts dry before operating the motor again.

Scan electronics
Clean the case and the controls with a soft cloth lightly moistened with a 
mild detergent solution. Do not use any abrasive pads or solvents like alco-
hol or spirits.

Cleaning the sample holder guide bars



SOFTWARE AND DRIVER PROBLEMS
Problems and Solutions

The problems described here can occur during normal operation of the 
microscope. If the suggested course of action does not solve the problem, or 
the problem is not described here, refer to section Nanosurf support at the 
end of this chapter.

Software  and Driver problems

No connection to microscope

This error message appears when the easyScan 2 software is waiting for an 
answer from the controller. Most likely, the easyScan 2 controller is not 
connected to the mains power, or not turned on. In this case the status 
lights on the top of the electronics are not on.

- Check the connection and the power switch.

USB Port error

The USB serial converter is not available. The USB cable is not properly 
connected. In this case the USB power light on the easyScan 2 controller
rear panel) does not light up. (figure The easyScan 2 Controller (p.19))
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- Check if the a second copy of the easyScan 2 is already running and occu-
pying the USB port.

- Check that the USB cable is properly connected.

If this does not solve the problem, check if there is a driver problem with 
the USB Serial port/USB Serial converter drivers, as described below.

Driver problems
If you have trouble connecting to the controller, or the video image in the 
positioning window is not available, it is possible that one of the drivers of 
your instrument is causing problems, for example because the installation 
did not work, or the installation of some other hardware is in conflict with 
the drivers of the easyScan 2 controller. In order to solve driver problems:

- Check for driver updates on the Nanosurf Support web site.

- Insert the installation CD for your instrument.

- Log in on an administrator account

Now open the device manager:

- Open the windows menu ‘Start>Settings>Control Panel’.

The control panel now opens. 

- Click ‘Switch to classic view’ if you do not see an icon called’ System’.

- Double-click the System icon.

The System properties dialog now opens.

- Select the tab ‘Hardware’

- Click the ‘Device Manager’-button.

The device manager now opens.

When the device manager opens, and your controller is connected to your 
computer you may see the drivers shown in figure Device manager, depend-
ing on the configuration of your controller:

• Generic USB Hub: all controllers
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Device manager: The drivers that may be installed on your system when your controller is 
connected to the computer.
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• USB Serial converter, USB Serial port: all controllers

• USB Video Adapter: Video Module version 1

• USB Composite device, USB 2.0 A/V Converter, USB EMP Audio 
Device: Video Module version 2

• HID-compliant device, USB Human Interface Device: Nanosurf Analy-
sis/SPIP

• Aladdin HASP key, Aladdin USB key: Nanosurf Report

If there are problems with any of these drivers, or a wrong driver is 
installed, you can try the following to fix it:

- Double click on the driver.

Properties dialog for the device now opens.

- Select the ‘Driver’-tab.

- Click the ‘Update Driver’-button

Windows will now ask you were to look for the driver.

- Tell windows to take the driver from the Installation CD.

STM measurement problems

Manual approach is too slow / stops sometimes
If the manual approach using the approach motor (buttons  and 

) is affected:

- Clean the sample holder guide bars and the surfaces of the approach 
motor following the procedure described in chapter Maintenance (p.63).

Automatic final approach is too slow / stops sometimes
Even if the manual approach works, the automatic final approach (button 

) may not work.

- Clean the sample holder guide bars and the surfaces following the proce-
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dure described in chapter Maintenance (p.63).

If cleaning does not help the step size may be too small:

- Open the User Interface configuration dialog using the menu 
‘Options>Config User Interface...’.

- Set the User Interface Mode to ‘Standard level’ or ‘Advanced level’.

- Increase the value of Appr. Speed in the Approach Options section of the 
Approach Panel by a few percent until the approach works.

Now the motor moves the sample holder with larger steps during automatic 
approach.

- Save the new value of Appr. Speed using the menu ‘File>Parame-
ters>Save’.

Automatic final approach crashes the tip into the sample
In this case the motor moves the sample holder towards the tip with too 
large steps:

- Open the User Interface configuration dialog using the menu 
‘Options>Config User Interface...’.

- Set the User Interface Mode to ‘Standard level’ or ‘Advanced level’.

- Decrease the value of ‘Appr. Speed’ in the Approach Options section of 
the Approach Panel by 10%.

- Repeat the approach with a new tip. If the approach fails again, reduce 
‘Appr. Speed’ further.

- Save the best ‘Appr. Speed’ value using the menu ‘File>Parameters>Save’.

Image quality suddenly deteriorates
There are several possible causes:
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Z-Drift
The tip drifted outside the Z-range of the scanner. In this case, the Probe 
Status light will either light up orange or red. If the light is orange, the tip 
has lost contact with the sample:

- Click  in the Approach Panel then repeat the steps in chapter 
First Measurements (p.37).

If the light is red, the tip has drifted into the sample. You can try to move 
the sample surface within the Z-range of the scanner, although the tip may 
already have been damaged:

- Click  in the Approach Panel.

If the light is still red after withdrawing, prepare a new tip (sectionPreparing 
and installing the STM tip (p.30)).

- Click .

XY-Drift
The scanner may have drifted close to a deformity in the sample's surface. 
Try to find a different measurement position:

- Increase the scan range.

- Zoom into a flat area.

Tip modification
The tip may have picked up some particles or other material from the sam-
ple surface. In this case, follow the instructions given in chapter Improving 
measurement quality (p.50).

Nanosurf support

Self help
The fastest way to solve a problem is often to solve it yourself. If the previ-
ously suggested actions did not help, or the problem is not described here, 
refer to the Nanosurf support pages:
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- Open www.nanosurf.com.

- Click on support.

- Enter the combination of serial number and password that you received 
on registering.

- Select the easyScan 2 link.

- If the problem is software related, try to upgrade to the latest version, 
and/or read the What’s new file to see if the problem was solved. For the 
solution to other problems, refer to the Frequently Asked Questions 
(FAQ).

If your instrument was not registered already, you will first have to register 
to get a password.

Assistance
If the standard solutions are not sufficient, contact your local distributor for 
help. In order to resolve the problem as fast as possible, please provide as 
much information as possible, such as:

• A detailed description of what happened before the problem occurred. 
For example: ‘When I click the approach button, then quickly click 
abort, the Controller will not react to any I do anything any more.’

• If an error message was displayed: The exact text of the message, or at least 
its start.

• The serial number of your scan head and/or Controller.

• A description of the computer hardware and software on which the con-
trol software is running: computer brand, type (lap-/desktop), operating 
system, software version etc.

• Original Nanosurf image data (.nid) files that show the problem, rather 
than bitmap screen shots, because these files contain all the settings that 
were used to make them.

• Parameter (.par) files with the instrument settings that were used when 
the problem occurred.
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STM Theory

What is STM?

Microscopy is one of the most exciting scientific techniques. The insight 
into small dimensions has led to a new understanding of the structure of 
materials and forms of life.

With the help of the scanning tunneling microscope (STM) it is possible to 
look into the fascinating world of the atoms. This completely new micros-
copy technique works without focusing elements and features atomic reso-
lution (laterally and vertically).

The Scanning Tunneling Microscope was developed by Gerd Binnig and 
Heinrich Rohrer in the early 80’s at the IBM research laboratory in Rüsch-
likon, Switzerland. For this revolutionary innovation Binnig and Rohrer 
were awarded the Nobel prize in Physics in 1986.

In the STM, a small sharp conducting tip is scanned across the sample’s 
surface, so close that the so-called ‘tunneling current’ can flow. With the 
help of that current the tip-surface distance can be controlled very precisely. 
Therefore an enormous resolution is achieved so that the atomic arrange-
ment of metallic surfaces can be ‘probed’.

To be able to get such excellent pictures of atomic resolution is almost 
incredible, considering that the size of the atom in relation to the tip is that 
of a golf ball to a mountain.

Scanning with the easyScan 2 STM

In the easyScan 2 STM, a platinum-iridium tip is moved in three dimen-
sions using piezo-crystal translators that are driven with sub-nanometer 
precision.

The sample to be examined approaches the tip within a distance of 1 nano-
meter (1nm= 1 / 1 000 000 000 m). Classical physics would prohibit the 
appearance of electrons in the small gap between a tip and a sample, but if 
a sharp tip and a conducting surface are put under a low voltage (U~0.1V) 
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a very small tunneling current (I~1nA) may nevertheless flow between tip 
and sample. This tunneling current is due to a quantum physics effect.

The strength of the tunneling current depends exponentially on the dis-
tance between the tip and the sample (usually referred to as Z-distance). 
This extreme dependence on the Z-distance makes it possible to measure 
the tip-sample movement very precisely. One of the three piezo crystals, the 

Piezo

Sample

Backward scan

Forward scan

Sample holder
Z

Y
X

73



STM THEORY

74
Z-piezo, can now be used in a feedback loop that keeps the tunneling cur-
rent constant by appropriately changing the Z-distance.

To obtain an image of the sample, the tip is scanned using the X- and Y-
piezo crystals. The feedback loop will now let the tip follow the structure of 
the sample's surface. A height image can now be made by recording the 
position of the Z-feedback loop as a function of the XY-piezo position. This 
‘landscape’ (or topography) of the atomic surface is then drawn line by line 
on the computer screen.

Feedback loop: The feedback loop maintains a constant tunneling current between the tip and the 
sample during motion in the X-direction by changing the Z-direction (viewed from top)

STM image of graphite

x

z

I = const.
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The sample can also be scanned in a second mode: When the feedback loop 
is slowed down very much, the tip scans at a fixed distance from the sample 
(constant height mode). This time the variations in the tunneling current 
are measured and drawn line by line on the computer screen. However, this 
mode only works when the sample is atomically flat, because the tip would 
otherwise ‘crash’ in to the sample.
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The user interface

This chapter explains the general concepts of the user interface that controls 
the functions of the easyScan 2 software. These functions are:

• Setting up the Nanosurf easyScan 2 STM hardware,

• moving toward the measurement position,

• performing measurements,

• displaying the measurement results,

• evaluating the measurements,

• permanently storing measurements and instrument.

These functions can be accessed via the easyScan 2 software, which is called 
‘workspace’. In the following, the workspace will be explained first, then the 
actual functions of the software will be discussed in more detail. The work-
space of the easyScan 2 software consists of the following parts:

1. The main window,

2. operating windows,

3. measurement document windows,

4. tool bars,

5. control panels.

The main window

The main window is opened as soon as the easyScan 2 software starts. It 
gives access to the whole functionality of the easyScan 2 software, and con-
tains all other windows:

• The Main menu.

• Operating windows that are used to perform specific operations with the 
microscope.

• Measurement document windows that are used to evaluate previously 
made measurements.
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• Several tool bars that are used to issue commands. 

• Several control panels that are used to set measurement parameters.

• The Navigator that is used to quickly select between the most often used 
operating windows and panels.

• The Status bar that displays the state of the instrument.

Operating windows

Operating windows are used to perform specific operations with the micro-
scope. These operations are controlled using specific panels and tool bars 
that are part of these windows. The Operating windows are:

• Positioning window: positioning the tip with respect to the sample, with 
the aid of the built-in optical microscope (chapter Positioning (p.104)).

The main window

Navigator Main menu Tool bar

Operating windowPanel Status bar
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• Imaging window: generating images of the sample (chapter Imaging
(p.109)).

• Spectroscopy window: measuring various ‘A as a function of B’ curves at 
certain sample locations, such as force-distance curves, or current-voltage 
curves (chapter Spectroscopy (p.117)).

Measurement document windows

The Measurement document windows visually represent previously made 
measurements. They are created when you decide to keep the current meas-
urement result. The measurement documents are used for storing, loading, 
printing and evaluating measurements. The measurement document is 
described in more detail in the chapters Viewing measurement data (p.123)
and Storing measurements and further data processing (p.140).

Tool bars

The tool bars can either be free floating windows (figure below, left), or they 
can be ‘docked’ to the top or the sides of the window they are associated 
with (Figure below, right).

 

Most tool bars dock to the Main window, some dock to a task specific win-
dow. 

Arranging tool bars
The tool bars have several features that allow you to arrange them in a way 
that is most efficient for your application.

To display a tool bar that is invisible, select the window it is associated with, 
and tick the tool bar’s name in the View menu. 

To dock a tool bar to the sides of its associated window, or to the side of, or 
below another tool bar that is already docked to this window, drag its title 
bar using the mouse cursor.
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To move a docked tool bar, use the mouse cursor to drag its handle on the 
left side of the tool bar. When the mouse cursor is over the handle, the 
cursor changes to a four pointed arrow.

To un-dock a docked tool bar, double click its handle, or drag the handle 
outside the area reserved for tool bars on the sides of its associated window.

Control panels

Just like the tool bars, control panels can be either be free floating windows, 
or they can be ‘docked’ to the sides of the window they are associated with. 
Most control panels dock to the Main window, some dock to a task specific 
window. The control panels give access to specific functions of the easyScan 
2 STM. The control panels contain one or more function sections, that can 
be collapsed and opened by clicking on the section header.

The number of visible sections and the number of visible parameters 
depends on the user interface mode selected in the User Interface Configu-
ration dialog (section The User Interface Dialog (p.83)). To see in which user 
interface mode a certain parameter is available, look at the title of the man-
ual section in which it is described.

A stack of panels

Section header

Title bar

Section

Label

Parameter
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Arranging control panels
The control panels have several features that allow you to arrange them in 
a way that is most efficient for your application.

A control panel associated with the main window is opened and brought on 
top of the other windows by clicking on its icon in the navigator. Any con-
trol panel can be opened and brought on top of the other windows, by 
selecting the window it is associated with, and ticking the panel’s name in 
the View menu.

Control panels can be stacked to save display space. When panels are 
stacked, labels are displayed on the bottom of the control panel stack. To 
put a control panel on top of the stack, click its label. To add a control panel 
to a stack, drag either its title bar or its label to either the title bar or labels 
of the stack. To remove a panel from a stack, drag its label away from the 
stack.

To dock a (stack of ) panels to the side of its associated window, or to the 
side of, or below another panel that is already docked to this window, drag 
its title bar to the desired position using the mouse cursor.

It is possible to scroll the content of a control panel up and down, when it 
is too small to display all the parameters it contains. To do this, move the 
mouse cursor over an area where it changes to a four pointed arrow. Then, 
drag the content up and down with the mouse cursor.

Storing and retrieving the workspace
When panels are opened, they appear at predefined places in the main win-
dow. This arrangement of the ‘workspace’ is stored in the configuration file 
‘Default EZ2-AFM.gui’ or ‘Default EZ2-STM.gui’ by default. The loca-
tion of the configuration files on the hard-disk depends on the operating 
system you use. Functions for storing and retrieving the workspace are 
accessed via the menu ‘File>Workspace’.

‘Save’ saves the workspace to the currently selected workspace file.

‘Save as...’ saves the current arrangement of the panels under another name.

‘Load’ loads a previously saved workspace.
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Entering values in the control panels
To change a parameter in any panel, use on of the following methods:

• Activate the parameter by clicking it with the mouse pointer, or by select-
ing it with the Tab key.

• The value of an activated parameter can be increased and decreased using 
the up and down arrow keys on the keyboard. The new value is automat-
ically used after one second.

• The value of a numerical parameter can also be increased and decreased 
by clicking the arrow buttons  with the mouse pointer. The new value 
is automatically used after one second.

• The value of an active numerical parameter can also be entered using the 
keyboard.  
The entered value is used on pressing the ‘Enter’ or ‘Return’ key, or by 
activating another input.  
The entered value is discarded on pressing the ‘Esc’ key. 
Type the corresponding character to change the unit prefix: 

For example, if the basic unit is Volts, type ‘m’ to change to millivolts, 
type the space bar for volts, type ‘u’ for microvolts.

• The selection of a drop-down menu (e.g.: ) can be 
changed using the mouse or the up and down arrow keys on the key-
board.

Sometimes the program will change an entered parameter value to a slightly 
different value. This happens when the desired value is outside the range 
that the easyScan 2 Controller can handle, for example due to the resolu-

prefix keyboard key prefix keyboard key
femto f no prefix space bar
pico p kilo k
nano n mega shift - M
micro u giga shift - G
milli m tera shift - T

Unit prefixes with corresponding character
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tion limits or timing limits. The desired value is automatically changed to 
the nearest possible value.

Storing and retrieving measurement parameters
All measurement parameters are stored in a configuration file with the 
extension ‘.par’. When the easyScan 2 software is started, default values are 
loaded from a file that is selected in the Controller Configuration Dialog 
(section The Controller Configuration dialog (p.99)). Functions for storing 
and retrieving parameters are accessed via the menu ‘File>Parameters’.

‘Save’ saves the parameters to the currently selected parameter file. The 
name of this file is indicated in the status bar at the bottom of the main 
window.

‘Save as...’, saves the parameters under a new file name. 

‘Load’ loads a previously saved parameter file.

IMPORTANT
When you have not loaded another file, ‘Save’, will overwrite the original 
default parameter file with you current settings.
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The User Interface Dialog

The User Interface dialog is opened via the menu ‘Options>Config User 
Interface...’

Program Skin
Select the look of the easyScan 2 software you are most comfortable with. 
All screen-shots in this manual were made with the Windows XP skin.

User Interface Mode
Determines the number of parameters displayed in the various panels:

Easy level only those parameters that are absolutely necessary to 
do a measurement

Standard level the commonly useful parameters

Advanced level all available parameters

Options
Save workspace on exit
When active, the workspace settings are saved to the system registry when 
the software is exited (section Storing and retrieving the workspace (p.80))

Animated menu
When active, the opening of the menu is nicely animated.
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Hardware setup

Some changes to the hardware setup must be made during the operation of 
the microscope. Other changes are generally only made when the hardware 
is changed. The Operating mode panel and the Z-Controller panel are used 
to change the hardware setup during the operation of the instrument. The 
rest of the hardware setup is distributed over several dialogs that are reached 
via the Options menu. These panels and dialogs are discussed in this chap-
ter.

The Operating mode panel

The operating mode panel allows you to select the operating mode that you 
wish to use, and to set up several operating mode related parameters. The 
operating mode determines which signals are measured, and which signal is 
used to control the Z-position. To open the Operating mode panel, click 

 in the navigator.

The number of available modes depends on the Scan head and on the mod-
ules built into the easyScan 2 controller. The modules required to be able 
to use a certain operating mode are listed in table Operating modes and 
required modules. The modes can be divided into the static operating modes 
that control the Z-position using the Cantilever deflection, the dynamic 
operating modes that control the Z-position using the vibration amplitude, 
and the STM mode that controls the Z-position using the tunnelling cur-
rent.

Operating mode Required modules
STM STM scan head
Static force AFM Basic
Dynamic force AFM Basic, AFM Dynamic
Phase contrast AFM Basic, AFM Dynamic, AFM Mode Extension
Force Modulation AFM Basic, AFM Dynamic, AFM Mode Extension
Spreading Resistance AFM Basic, AFM Dynamic, AFM Mode Extension

Operating modes and required modules
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The signals measured with each of the operating modes are listed in table 
Operating modes and measured signals. Note that the names of the signals 
can be changed in the ‘Scan Head Calibration’ dialog.

STM mode
This mode is only available when an STM head is connected to the control-
ler. In this case, it is the only available mode setting.

Operating mode (Easy, Standard, Advanced)

Mounted cantilever (Easy, Standard, Advanced)
Not available, this input is only used for AFM modes.

Operating mode (Easy, Standard, Advanced)
STM mode by default.

Operating mode Signals measured 
Static force Topography, Cantilever deflection(, User Input 1, 

User Input 2)
Dynamic force Topography, Vibration amplitude(, User Input 1, 

User Input 2)
Phase contrast Topography, Vibration amplitude, Vibration 

phase(, User Input 1, User Input 2)
Force modulation Topography, Cantilever deflection, Vibration 

amplitude(, User Input 1, User Input 2)
Spreading Resistance Topography, Cantilever deflection, Tip current(, 

User Input 1, User Input 2)
STM Topography, Tip Current (User Input 1, User 

Input 2)

Operating modes and measured signals:  The User Inputs are only available when they are 
enabled and the Signal Module: A is installed.
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User Input/Output (Standard, Advanced)
See the description under Static Force mode.

Static Force mode
In the static force mode, the Operating Mode and User Input sections are 
available.

Operating mode (Easy, Standard, Advanced)

Mounted cantilever (Easy, Standard, Advanced)
The mounted cantilever type. The mounted cantilever type is used to auto-
matically determine the search range in the dynamic operating modes, and 
to determine the correct calibration for the force set point in the static oper-
ating modes.

Operating mode (Easy, Standard, Advanced)
Changes the operating mode.

User Input (Standard, Advanced)
Enable User Input1, 2

When active, the data from the User input (chapter The Signal Modules
(p.69)) is measured and stored. Enabling the user inputs significantly 
increases the measurement file size.
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User Output 1, 2
The output value of the user output.

Config...
Opens the User Signal Editor dialog.

The User Signal Editor

The User Signal Editor dialog is used for editing the calibration of the User 
input signal. It can be reached through the User Input/Output section of 
the Operating Mode Panel. The settings made in this dialog are stored in 
the Scan head calibration file.

Signal
Name
The name of the user signal. This name is used throughout the program to 
refer to the user signal.

Unit
The base unit of the physical signal, without prefix (i.e. m, not nm or µm).

Calibration
The physical signal values that correspond to the maximum and minimum 
signal voltages should be entered here. Prefixes can be used here.
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Dynamic Force mode
In addition to the same Operating mode and the User Input section as in 
the static operating mode, two sections of parameters may be available, 
depending on the user interface mode.

The dynamic force mode parameters can either be set manually or deter-
mined using an automatic search procedure. The automatic search starts 
with the coarse measurement of a cantilever resonance curve (figure Deter-
mination of the vibration frequency). Throughout this measurement, the 

cantilever is excited with a fixed amplitude, whilst the excitation frequency 
is varied. The resonance curve contains a measurement of the resulting can-
tilever vibration as a function of the excitation frequency. When the search 
is successful, the resonance curve contains a single peak at the free resonance 
frequency of the cantilever. Afterward, a second, fine-tuning search is per-
formed in a 3 kHz frequency range around the resonance frequency 
detected in the coarse search.

The computer adjusts the value of Vibration frequency so that the canti-
lever vibration amplitude is reduced by the amount set in ‘Amplitude reduc-
tion’ in the Freq. Peak Search section.

Mode Properties (Easy, Standard, Advanced)
Free vibration amplitude (Easy, Standard, Advanced)
The desired reference amplitude of the cantilever vibration. The cantilever 
vibrates at this amplitude when it is far away from the sample. The excita-
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THE OPERATING MODE PANEL
tion strength is adjusted so that this vibration amplitude is reached.

Vibration frequency (Standard, Advanced)
The frequency at which the cantilever vibrates during the measurement. 
This frequency can automatically be set as described at the start of this sec-
tion. When ‘Auto set’ is enabled, the Vibration frequency is automatically 
set each time an approach is started. Clicking  starts the automatic 
setting immediately. 

Display sweep chart (Standard, Advanced)
When active, the results of the vibration frequency search measurements are 
transferred to a measurement document, and displayed on the screen.

Freq. peak search (Advanced)
The parameters for the automatic vibration frequency search are set here.

Start frequency (Advanced)
The start frequency for the coarse search

End frequency (Advanced)
The end frequency for the coarse search

 

Cantilever resonance curve: left: coarse search; right: fine-tuning search
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Step frequency (Advanced)
The difference between two frequency points at which the cantilever vibra-
tion amplitude is measured during the coarse search. If the increment is 
large, the search takes less time. When however the increment is too large, 
there is a risk that the resonance frequency may not be found.

Auto set (Advanced)
When active, the range and frequency increment are automatically set to 
suitable values for currently selected cantilever type.

Amplitude reduction (Advanced)
Indirectly determines the ‘Vibration Frequency’ in the ‘Auto set’ mode: The 
computer adjusts the Vibration frequency so that the cantilever vibration 
amplitude is ‘Amplitude reduction’ percent smaller than the vibration 
amplitude at the resonance frequency. 

Use upper sideband (Advanced)
When active, the vibration frequency is set larger than the resonance fre-
quency. Otherwise, the vibration frequency is set smaller. 

Phase Contrast mode
In addition to the parameters in the Dynamic Force operating mode, the 
Reference Phase is available in the Standard and Advanced user interface 
modes.

Reference Phase (Standard, Advanced)
The reference phase for the detected cantilever vibration. Changing the ref-
erence phase changes the offset of the phase signal. The phase reference can 
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be automatically set so that the phase signal is zero. When ‘Auto set’ is ena-
bled the phase reference is automatically set after finishing the approach. 
Clicking  starts the automatic setting immediately. 

Force Modulation mode
In addition to the parameters in the Static Force operating mode, two addi-
tional parameters are available.

Excitation amplitude
The amplitude of the sensor excitation during a force modulation mode 
measurement.

Excitation frequency
The frequency of the sensor excitation during a force modulation mode 
measurement. Clicking  starts a measurement of the cantilever reso-
nance curve, that helps you to select the excitation frequency. The settings 
for this measurement are the same as those for the Dynamic Force measure-
ment.

Spreading Resistance mode
The operating mode panel for the Spreading Resistance mode is the same 
as that for Static Force operating mode.

The Z-Controller Panel

The tip-sample interaction is normally kept constant using the Z-Control-
ler. The Z-Controller is a PI(D) controller as is shown in figure Z- Control-
ler. The settings of this controller are set in the Z-Controller panel. To open 

the Z-Controller panel, click  in the Navigator.

Z-Controller (Easy, Standard, Advanced)
Set point (Easy, Standard, Advanced)
The working point for the Z-Controller. Depending on the operating 
mode, this is the tunneling current (STM mode), cantilever deflection 
(static force mode) or relative cantilever vibration amplitude (dynamic force 
mode). In the latter case, the set amplitude is relative to the operating 
amplitude, set in the Operating mode panel. For example, when a set point 
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of 70% is used, the Z-Controller will move the tip closer to the sample until 
the vibration amplitude has decreased to 70% of the vibration amplitude 
far away from the sample.

Loop-Gain (Easy)
The speed of the Z-Controller. If the gain is too low, the Z-Controller will 
not follow the surface fast enough. Thus, the image will not be as sharp as 
it could be. If the gain is too high, the Z-Controller will overshoot and may 
start to oscillate. Thus, the image will contain many measurement artifacts.

P-Gain (Standard, Advanced)
The strength of the Z-Controller reaction that is proportional to the error 
signal. Increasing the P-Gain decreases the error signal.

I-Gain (Standard, Advanced):
The strength of the Z-Controller reaction that is proportional to the inte-
gral of the error signal. Increasing the I-Gain decreases the error signal over 
time. It is the least sensitive to noise, and usually the dominant contributor 
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THE Z-CONTROLLER PANEL
to the topography measurement.

D-Gain (Advanced)
The strength of the Z-Controller reaction that is proportional to the deriv-
ative of the error signal. Increasing the D-Gain decreases fast changes in the 
error signal, but also amplifies high frequency noise. The D-Gain is only 
available in the ‘Standard PID’ Z-feedback mode of the Z-Controller (see 
following section).

Z-Controller Mode (Advanced)

Z-Feedback Mode

Free Running The Z-Controller is active.

Freeze Position The Z-Controller is not active, the scanner remains in 
its current Z-position.

Stop and Clear The Z-Controller is not active, the scanner is moved 
to the ‘Ref. Z Plane’, set in the Imaging Panel.

The Probe Status light will blink green as long as the Z-Controller is deacti-
vated.

IMPORTANT
The tip may be damaged when the Z-Controller is not active during scan-
ning. This will definitely happen when Ref. Z Plane is much lower than the 
current position of the tip, or when the scan range contains large height 
differences.

Z-Feedback algorithm

Standard PID A standard PID controller is used for Z-Feedback.

Adaptive PI A standard PI controller is used for feedback. In addi-
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tion, the bandwidth of the Topography measurement 
is adapted to the number of measured points per sec-
ond.

The adaptive PI controller reduces noise in the measurement. However, 
topography changes that happen faster than the time between two meas-
ured points are also lost. This makes it more difficult to detect vibrations 
due to instability of the feedback loop. These vibrations remain visible in 
the Current, Amplitude or Deflection signal. Therefore, always monitor 
these signals when optimising Z-Controller settings, especially when using 
the Adaptive PI setting.

Error Range (Advanced)
The range of the error signal used to control the Z-Position. The error sig-
nal is the difference between the signal used for topography feedback and 
the current set point. When the value of ‘Error Range’ is reduced, the reso-
lution of the error signal is increased.

Tip Properties (Standard, Advanced)

Tip Voltage (Standard, Advanced)
The potential to be applied to the tip. The usable voltage range is between 
-10V and +10V. In the STM, the sample is automatically connected to the 
ground of the instrument. In the AFM, the sample has to be electrically 
connected to the instrument chassis ground for accurate measurements.

Cantilever types configuration

The cantilever types that you can select from in the Operating Mode Panel 
are configured using two dialogs: The cantilever browser, and the cantilever 
editor dialog. The cantilever types configuration is stored in a file called 
‘cantilever.ini’, located in the local settings directory of the user logged on 
to the PC.



CANTILEVER TYPES CONFIGURATION
The cantilever browser dialog

The cantilever browser dialog is opened via the menu ‘Options>Config 
Cantilever Types...’. The cantilever browser allows the editing and creation 
of cantilever types. 

New
Opens the cantilever editor dialog for a new cantilever type. You can create 
new cantilever types that are not defined in the default configuration. The 
AFM head requires the following cantilever properties:

• The bottom of the sensor chip must have grooves that fit into the align-
ment chip.

• The cantilever should have a nominal length of 225 µm or more, and a 
width of 40 µm or more.

• The back of the cantilever must have a coating that reflects infrared light. 
Uncoated cantilevers transmit much of the infrared light of the deflection 
detection system.

Edit...
Opens the cantilever editor dialog to modify the currently selected canti-
lever type.

Delete...
Deletes the currently selected cantilever type using the cantilever editor dia-
log.
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The cantilever editor dialog

The following properties of a cantilever type are entered in this dialog:

Name of cantilever
The name of the cantilever type. This name appears in the cantilever 
browser and the Cantilever type drop-down in the Operating Mode Panel.

Spring constant
The (nominal) spring constant of this cantilever type. This value is used to 
calculate the correct force Set point in the operating modes that use the 
static force for Z-Control. (section Static Force mode (p.86))

Resonance frequency
The (nominal) resonance frequency of the cantilever type. This frequency 
is used for the calculation of the automatic resonance frequency search 
range (section Dynamic Force mode (p.88)).

Scan head configuration

The scan head configuration is used to store all calibration values specific 
to a certain scan head. The configuration of each scan head is stored in a 
file with the extension ‘.hed’. This file is copied from the software installa-
tion CD on installation of the instrument. When you change the scan head, 
you should also load the correct configuration file.

The scan head selector dialog
The scan head selector dialog is opened via the menu ‘Options>Config 
Scan Head...’. 



SCAN HEAD CONFIGURATION
Load...
Loads a different scan head configuration file.

Save as...
Saves the current scan head configuration under another name.

Edit...
Edit the currently loaded scan head configuration using the scan head cali-
bration dialog. Always save a backup of the Scan head configuration by 
clicking ‘Save As...’.

The scan head calibration editor

In this window the calibration of all standard Inputs and Outputs can be 
configured individually along with some scanner. The configuration of the 
User inputs and outputs is located in a different dialog (section The User 
Signal Editor (p.87)).

IMPORTANT 
Changes to these settings should be performed with great care. False set-
tings can lead to false interpretation of the data and incorrect operation of 
the controller.
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Scan Axis, Maximum scan ranges
X/Y/Z-Axis Range
The calibration values of each of the scanner axes. The calibration values are 
given as the maximum motion range of the scanner (when Overscan is set 
to 0%).

Set
Opens the scan axis correction dialog (see next section).

Scan Axis, Axis Orthogonality
The X- and Y-Axes of the scanner are generally not perfectly orthogonal, 
and their orientation with respect to the AFM housing may vary. The easy-
Scan software corrects these errors by adding/subtracting some of the X 
scanner command signal to the Y scanner command signal and vice versa.

X/Y Angle
The angle between then the X and Y axis of the scanner hardware. The 
software uses this value to correct the scan command signals such that the 
scan axes are orthogonal.

Rotation
The angle between the X axis of the scanner and the X axis of the micro-
scope body (figure Scanner coordinate system (p.84)). The software uses this 
value to correct the scan command signals such that the scan axis is parallel 
to the X axis of the microscope body. 

I/O Signals, Maximum input signal values
Deflection
The calibration of the cantilever deflection signal.

Amplitude
The calibration value of the cantilever vibration amplitude signal.

Phase
The calibration value of the cantilever vibration phase shift signal.

Tip current
The calibration value of the internal Tip current measurement
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I/O Signals, Maximum output signal values
Tip Potential
The calibration value of the Tip voltage setting.

Drive Amplitude
The calibration value of the Amplitude of the signal that is used to excite 
the cantilever. The Drive Amplitude signal is only displayed in the Data 
Info Panel.

The Scan Axis Correction Dialog

This dialog can be used to multiply the scan axis calibration factor by a 
correction coefficient that has been determined by evaluating the measure-
ment of a calibration gird, for example using SPIP/Nanosurf Analysis.

Scan axis correction
The Scan range is multiplied with this number when the ‘Set’-Button is 
clicked.

The Controller Configuration dialog

The Controller configuration dialog is opened via the menu 
‘Options>Config Controller...’. On a correctly configured system, it should 
not be necessary to change the settings in this dialog, except for the start-
up parameters and chart arrangement file configuration.
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Start configuration
The parameter and chart arrangement files that are loaded when the soft-
ware starts (section Storing and retrieving the chart arrangement (p.124)).

USB Connection
The easyScan 2 controller uses a virtual serial port that is connected to the 
USB port. The number of this virtual serial port should be the same as the 
one shown in your the windows device manager dialog.

Video Signal
The configuration of the easyScan 2 controller’s internal video capture 
device. The default configuration should normally not be changed. This 
feature is only available when the video camera is installed.

Microscope Firmware
Click the Update button to install firmware updates that you receive from 
Nanosurf support.
0
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The Edit Access Codes Dialog

The Edit Access Codes Dialog is used to enter the access code for software 
modules. At the moment, the only software module is the scripting inter-
face. The dialog is accessed via the menu entry ‘Options>Config Access 
Codes...’

The Scan head Diagnosis dialog

The Scan head Diagnosis dialog is opened via the menu ‘Options>Check 
Scan Head...’. In it, the controller reports the current status information of 
the sensor or the approach platform. If the Status light on the easyScan 2 
controller is blinking red, more detailed information about the failure is 
displayed in the ‘Microscope Diagnosis’ dialog.

Simulate Microscope

Check or uncheck the menu item ‘Options>Simulate Microscope’ to enter 
and exit the simulation mode. Once the simulation mode is active, the first 
field in the status bar of the easyScan 2 software displays the text ‘Simula-
tion’, otherwise this field displays the text ‘Online’.
101



HARDWARE SETUP

10
In the simulation, many functions of the microscope are performed on a 
mathematically generated surface. Thus, the software functionality and 
working methods of the microscope can be practised.

The About dialog

The About dialog displays various information that may be useful for diag-
nostics when you have problems with your instrument. To open the About 
dialog:

- Select the menu entry ‘?>About...’.

The about dialog contains the following information:

• the version number of the control software

• the serial number of the controller

• the version number of the firmware that is running on the controller

• the version number of the built-in modules
2
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• contact information for getting more support.

When the microscope simulation is active, the about dialog displays the 
serial number ‘000-00-000’ is displayed. The Nanosurf Web site and con-
tact address for information and software updates are also displayed here.
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Positioning

The Positioning window contains all the software tools for positioning the 
tip with respect to the sample:

• The Approach panel

• The Video panel (with the Video Module)

• The Video display (with the Video Module)

Click  in the Navigator to open the Positioning window.

The Approach panel

The motor for the tip-sample approach is operated using the ‘Approach 
Panel’. 
4
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Approach (Easy, Standard, Advanced)

Status
Displays the current status of the approach stage.

Increases the tip-sample distance at maximum speed until the button is 
released.

Decreases the tip-sample distance at maximum speed until the button is 
released.

Increases the tip-sample distance with the settings given in the Approach 
Options.

Starts the automatic approach. During the automatic approach, the tip-
sample distance is decreased until the Set point, set in the Z-Controller 
panel, is reached, or until the maximum approach time is reached.
105



POSITIONING

10
Approach Options (Standard, Advanced)

Tip-Position (Advanced)
Determines the Z-Position of the scanner when the approach motor stops. 
When the Tip-Position is changed when the tip is already approached to 
the sample, the motor will move the approach stage so, that the Z-Position 
of the tip becomes equal to the set Z-Position. When a high resolution 
(2 µm Z-Range) scanner is used, the Tip-Position before the approach is set 
to +500 nm Advanced by default. This compensates for the residual motion 
of the approach stage that occurs after the approach motor has stopped.

CAUTION
Changing the Z-Position when the tip is approached to the sample may 
cause tip damage when using high resolution scanners. This can be due to 
play in the approach stage, which is caused by a change in the initial load 
of the approach stage bearings. Contact your local Nanosurf representative 
if this seems to be the case.

The Tip-Position setting can for example be useful when a sample is mainly 
a large flat surface with some deep holes in it. In this case proceed as follows:

- Ideally, first make sure that the center position of the Scan range is outside 
a hole. 

When the Scanner is idle (such as during approach), the tip is always 
brought to the center position of the scan range.

- Set Tip-Position to about 80% of the maximum value.
6
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- Click Approach

The Tip-Position setting can not be used with STM scan heads, which is 
due to the different approach motor used in the STM.

Stop button
Stop the adjustment of the height 

Appr. speed (Standard, Advanced)
The speed of the motor during the automatic approach and withdraw. 
When an STM scan head is used, the Approach speed changes the Step size 
of the approach motor, the step frequency is determined by the speed of the 
feedback loop.

CAUTION
If the approach is too fast, the tip or the sample surface can be damaged. 
On the other hand, the motor will not move when Appr. speed is too small.

Max. Withdraw (Standard, Advanced)
The maximum withdraw duration after clicking .

Max. Approach (Advanced)
The maximum approach duration after clicking .

Auto. start imaging (Standard, Advanced)
When selected, the system automatically starts imaging after a successful 
approach. Scanning is automatically stopped when the approach motor is 
moved.

Auto reload settings (Advanced)
When selected, the software reloads the default start-up parameter file each 
time an approach is started (section The Controller Configuration dialog
(p.99)).

The Video panel

The video panel controls the video display in the Positioning window.
Changing these settings only has effect when a Video camera is fitted on 
your system.
107



POSITIONING

10
Video source

The video source section determines which video signal is currently dis-
played.

Switches the video display to the top view.

Switches the video to the side view.

Saves the currently displayed image to a JPEG file that is selected using a 
Save file as... dialog.

Video Options

The Video Options section determines how the video signal is displayed. 
There are separate sets of options for the side and the top view.

Illumination
The intensity of the sample illumination on the scan head.

Brightness
The brightness of the video display

Contrast
The contrast of the video display
8
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Imaging

Imaging measurements of the sample are controlled using the Imaging win-

dow. The Imaging window can be opened by clicking  in the navigator. 
The Imaging window contains the Imaging bar, with commands that con-
trol the imaging processes, and the Imaging panel, with parameters that 
determine how the imaging is done.

The Imaging window also contains a number of charts that display the data 
from the ongoing measurement. The imaging window can display as many 
charts as the size of the window can accommodate. By default, two charts 
are displayed, a Line graph, and a Color map of the sample’s Topography. 
For more information on adding and changing charts (chapter Viewing 
measurement data (p.123)).

The imaging window
109



IMAGING

11
The imaging bar

/
 starts a measurement and then changes to . Clicking  

aborts the measurement as soon as the current scan line is finished.

After clicking  the measurement stops when the current measurement 
has finished.

/
Starts a single measurement or changes the scanning direction of the meas-
urement in progress. With  the image is scanned from the bottom to 
top, with  it is scanned from the top to the bottom. If a measurement 
has been started using  or  the measurement stops automatically 
after one full image.

Selects an area that is to be measured in more detail. The size and area of 
the area is displayed in the Tool Results panel.

One corner of the zoomed area is defined by the mouse cursor position 
where the left mouse button is clicked, the opposite corner by the position 
where the button is released. When the mouse is not moved between click-
ing and releasing, an area is defined that has a size of 33% of the current 
measurement, and centred on the clicked location. Once an area is defined, 
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THE IMAGING BAR
it can be resized by dragging one of its corners, and moved to the desired 
position by dragging its centre point.

A double click with the left mouse button in the chart, or clicking the 
Zoom button in the Tool Results panel, modifies the parameters Scan 
range, X-, Y-Offset in the Imaging window accordingly. When the zoom 
function is active it can be aborted by clicking  again.

Moves the position of the imaged area. An interesting corner can thus be 
moved to the centre of the measurement. The Tool Results panel numeri-
cally displays the change in position.

The change in the position is indicated by an arrow. The start of the arrow 
is defined by the mouse cursor position where the left mouse button is 
clicked, the end of the arrow by the position where the button is released. 
When the mouse is not moved between clicking and releasing, an arrow 
ending in the centre of the measurement is drawn. The direction of the 
arrow can be adjusted by dragging its end markers, it can be moved by 
dragging the centre marker.
The image is moved by double clicking, or clicking the Move button in the 
Tool Results panel. The move function can be aborted by clicking  
again.

Returns the parameters Scan range to the largest possible values, and ‘X-
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Offset’ and ‘Y-Offset’ to zero.

Transfers the current measurement data to the spectroscopy window. If a 
measurement is in progress, it is interrupted. It is advisable to use  to 
complete the current measurement before starting the spectroscopy meas-
urement.

Captures the measurement currently displayed in the ‘Imaging window’ in 
a measurement document.

If  is clicked when a scan is in progress, a new measurement document 
is generated each time a measurement is finished. The capture process is 
cancelled by clicking  a second time.

To capture an image without waiting for the scan to be completed, stop the 
scanning by clicking . The image can then be captured immediately 
by clicking .

The measurement documents are labelled automatically with increasing 
numbers (i.e. Image1, Image2,...). When leaving the program you will be 
asked if you want to save the unsaved measurement documents. 

The Imaging panel

The imaging settings use two coordinate systems: The Scanner coordinate 
system and the Measurement image coordinate system. To separate the two 
systems, the image axes are denoted by an asterisk (i.e. X*, Y*). The relation 
between the two coordinate systems is determined by various parameters in 
the imaging panel. The effect of these parameters is illustrated in figure 
Coordinate systems.

Imaging Area (Easy, Standard, Advanced)
Image size (Easy, Standard)
The image size in both the X* and Y* direction. The size is doubled or 
halved when using .

Image width (Advanced)
The image size in X* direction.
2
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Height (Advanced)
The image size in Y* direction. When the Check-box is active, the image 
Height is always identical to the Image width.

Points / Line (Easy, Standard, Advanced)
The number of measured data points per line. 

Lines (Advanced)
The number of measured data lines in an image. When the Check-box is 
active, the number of Lines is always equal to the number of Points / Line. 
In the easy and standard user interface mode, the number of Lines is always 
equal to the number of Points / Line. 

Time / Line (Easy, Standard, Advanced)
The time needed to acquire a data line. The time needed for the entire 
image is approximately:

Coordinate systems

X
Y

Z, Z*

Scanner XY-plane

'X-Slope' angle

'Y-Slope' 
angle

'Rotation' 
 angle

Measurement plane

Image area
X*Y*

Image time ´Time / Line´ ´Lines / Frame´ 2⋅ ⋅=
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Rotation (Easy, Standard, Advanced)
The angle between the X-direction of the scanner and the X* direction of 
the measurement (figure Coordinate systems).

Imaging Options (Standard, Advanced)

The reference plane for the image can be aligned to the surface of the sam-
ple using the slope parameters (figure Coordinate systems).

X-Slope (Standard, Advanced)
A positive value rotates the image plane around the Y-axis in the counter-
clockwise direction.

Y-Slope (Standard, Advanced)
A positive value rotates the image plane around the X-axis in the counter-
clockwise direction. 

The centre position of the measured area can be changed by typing its posi-
tion as well as by using the Move tool in the imaging bar. The zero position 
is the centre position of the scanner.

Image X-Pos, Y-Pos (Advanced)
The centre position of the measured area.

Overscan (Standard, Advanced)
The amount by which the scan range of each line is made larger than the 
measurement range, relative to the image width. Thus edge effects, caused 
by the reversal of the scanning motion, are not displayed in the measure-
ment. Disadvantages of using Overscan are that the maximum scan range 
is reduced, the tip moves slightly faster over the sample with the same 
‘Time/Line’ setting, and the tip may hit large features outside the measured 
image. The value of ‘Overscan’ determines how much the scan range is 
4
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increased relative to the Image width.

Ref. Z-Plane (Advanced)
The height of the reference plane. This height reference is used when the 
Z-Controller output is cleared, and when the Z-position is not modulated 
relative to the current surface position during spectroscopy measurements.

Imaging Modes (Advanced)

Scan mode
The Y* direction in which the data is acquired and displayed:

Continuous the acquisition direction is reversed after each scan: 
from bottom to top and vice versa

Cont.Up from bottom to top

Cont.Down from top to bottom

Measurement mode
The X* direction in which the data is acquired and stored:

Forward during forward scan only (left to right in the image)

Backward during backward scan only (right to left in the image)

Forw.&Backw. during both forward and backward scan

Const.-Height mode
When the Constant Height Imaging mode is enabled, the Z-Controller is 
turned off during the scan (as a consequence, the Sensor Status light will 
blink green). Instead, the scanner scans along a straight line, that should be 
parallel to the surface. The slope of the line is defined by the X- and Y-Slope 
parameters in the Imaging Options section of the Imaging Panel. These 
parameters should be set as described in section Adjusting the measurement 
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plane (p.54). The height of the line is determined at the start of each scan 
line: First the Z-Controller is turned on. Once the tip position is stable, the 
Z-Controller is turned off and the tip is moved away from the sample by 
the distance set by the parameter Rel. Tip-Pos.

The Constant Height Imaging mode is mainly useful for EFM and MFM 
measurements. For more information on how to do Magnetic Force 
Microscopy, refer to technical note TN00031 Magnetic Force Microscopy, 
which can be downloaded from the support section of the Nanosurf web 
site at www.nanosurf.com.

Rel. Tip-Pos
The distance by which the Tip is moved towards the sample from the posi-
tion that corresponds to the set point. A negative setting will move the tip 
away from the sample.
6
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Spectroscopy

In a spectroscopic measurement, the input channels are measured as a func-
tion of a modulated parameter. This modulated parameter can be the Z-
distance to the sample, the tip voltage, or a User output channel (when the 
Signal Module: A is installed). Note that you must electrically connect the 
sample to the ground connector on the easyScan 2 STM AFM scan head to 
apply a tip-sample voltage difference. The measured parameter can be any 
available input channel. Examples of a spectroscopic measurements are 
force/distance curves in the AFM static force mode, amplitude/voltage 
curves in the AFM dynamic mode, or current/voltage curves with the STM.

The accuracy of the spectroscopic measurements can be increased by aver-
aging the measurement results of several consecutive modulations. A spec-
troscopic measurement sequence consists of a number of spectroscopic 
measurements of the same type, measured along a user defined line in the 
XY-plane. A point measurement is made if the number of points is one. The 
measurement sequence is carried out as follows:

1. The tip is moved with active Z-control to the start of the line.

2. The Z-Controller is switched off.

Spectroscopy window
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3. A spectroscopic measurement is recorded.

4. The Z-Controller is turned on again.

5. The tip is moved to the next point on the line in the XY-plane.

Steps 2.-5. are repeated for each points on the line. 

Spectroscopic measurement sequences are controlled using the Spectros-
copy window. The Spectroscopy window can either be opened by clicking 

 in the navigator, or by clicking  in the Imaging bar. When the 
Spectroscopy window is activated from the Imaging bar, the currently 
measured image is transferred to the Spectroscopy window. 

The Spectroscopy window contains the Spectroscopy bar, with commands 
that control the spectroscopy processes, and the Spectroscopy panel, with 
parameters that determine how the spectroscopy measurement is done. 

The Spectroscopy window also contains a number of charts that display the 
data from a previous imaging measurement and the data from the ongoing 
spectroscopic measurement. The Spectroscopy window can display as many 
charts as the size of the window can accommodate. It is recommended to 
display at least two charts, one a Color map of a previous Topography meas-
urement of the area where the spectroscopy measurement is performed, and 
one a Dual Line graph of the current spectroscopy measurement. For more 
information on adding and changing charts (chapter Viewing measurement 
data (p.123)).

The Spectroscopy bar

/
 starts a spectroscopy measurement sequence and then changes to 
 until the measurement sequence is finished. Clicking  aborts the 

measurement sequence as soon as the current modulation period is fin-
ished. 

/
Starts the selection of the XY measurement position(s) in a topography 
Color map chart using the mouse cursor. These positions are automatically 
transferred to the appropriate entries in the Position section of the Spectros-
8
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copy panel. When selecting a line, clicking the chart once creates a line from 
the clicked position to the centre of the image.

Captures the measurement currently displayed in the Spectroscopy window 
in a measurement document, and displays it in a separate window.
If  is clicked during the measurement, a copy is generated when the 
measurement in progress is finished. During the measurement, the button 
remains pressed. The capture process is cancelled by clicking  a second 
time.

The measurement documents are labelled automatically with increasing 
numbers (i.e. Image1, Image2,...). When leaving the program you will be 
asked if you want to save the unsaved measurement documents.

The Spectroscopy panel

Modulation (Easy, Standard, Advanced)

Modulated output (Easy, Standard, Advanced)
The number of available modulated outputs depends on the scan head and 
the number of installed modules operating modes that are available. Possi-
ble values are: ‘Z-Axis’, ‘Tip Potential’ and the names of the User Outputs.

Start value/End value (Easy, Standard, Advanced)
The range over which the Modulated output is changed. The ‘Spec For-
ward’ data is measured from the Start to the End value, the ‘Spec backward’ 
data is measured in the opposite direction. The ‘Spec forward’ data is always 
measured before the ‘Spec backward’ data.
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Relative to current value (Standard, Advanced)
When active, the Start and the End values are added to the value the mod-
ulated output had before starting the modulation.
When the Tip Potential is modulated, the current value is the Tip voltage 
set in the Z-Controller panel. 
When the Z-Axis is modulated, the current value is the sample surface 
height, as measured using the Z-Controller output. Otherwise, the meas-
urement z-position is given by the value of the Ref. Z-Plane in the Imaging 
Panel.

Modulation time (Easy, Standard, Advanced)
The time used to change the Modulated output from the Start to the End 
value.

Keep Z-Controller active (Advanced)
The Z-Controller will continue to change the Z-position so as to keep tip-
sample interaction constant. This option is not available when the Modu-
lated output is set to the Z-Axis. 
This setting can for example be used to measure tip current as a function of 
applied voltage whilst keeping the tip-sample force constant.

Measurement (Easy, Standard, Advanced)

Data points (Easy, Standard, Advanced)
The number of data points in one spectroscopic measurement. The data 
points are equally distributed over the modulation range.

Averages (Easy, Standard, Advanced)
The number of times the modulation is repeated to obtain an averaged 
spectroscopic measurement. The measurement results of aborted modula-
0



THE SPECTROSCOPY PANEL
tions are discarded during averaging.

Input range check (Standard, Advanced)
In order to prevent tip damage due to too high tip-sample interaction, the 
settings below ‘Input range check’ define a safe range of tip-sample interea-
cion. When the interaction signal (Deflection in static modes, Amplitude 
in dynamic modes, Current in STM mode) leaves this safe range, the meas-
urement is aborted. When a spectroscopy measurement has been aborted, 
a warning dialog is displayed. The number of aborts that occurred in a 
measurement is reported in Data Info panel as: ModAborted=<number of 
aborts>.

Abort action (Standard, Advanced)
What is to be done when the measurement is aborted:

No range check will never abort the measurement. The tip is not pro-
tected against damage due to too high tip-sample 
interaction. This is the default setting.

Abort modulation aborts the current modulation period, and continues 
with the next modulation until the number of modu-
lations in ‘Averages’ is reached.

Abort current measurementaborts the spectroscopy measurement for the 
current point and continues with the next point of the 
line, if a  spectroscopy is being performed. 

Abort measurement sequenceaborts the entire spectroscopy measurement 
sequence (cancels all ‘Averages’ and points).

Max / Min input value (Standard, Advanced)
The Minimum/maximum value that the feedback signal is allowed to have.

Position (Easy, Standard, Advanced)
The Position parameters can be used to define a sequence of spectroscopy 
measurements on positions that are equally distributed over a line.

Sequence Points (Easy, Standard, Advanced)
The number of Spectroscopy Measurements to be made in the sequence.

X-Pos from/Y-Pos from (Easy, Standard, Advanced)
The XY-coordinates of the measured point in a -spectroscopy measure-
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ment. Sets the XY-coordinates of the starting point of the line in a -
spectroscopy measurement sequence.

X-Pos to Y-Pos to (Easy, Standard, Advanced)
The XY-coordinates of the end-point of the line in a -spectroscopy 
measurement sequence.

The from and to coordinates are more conveniently chosen using the  
or  tools in the Spectroscopy bar.
2



CHARTS
Viewing measurement data

Measurement data are displayed in charts. Charts are used in Measurement 
document windows, the Imaging window and the Spectroscopy window. 
The measurement settings are displayed in the Data Info panel.

Charts

A Chart is a graphical representation of the measured data, and additional 
elements that give information about the chart itself (figure Elements of a 
Chart).

These elements show the displayed Signal, Chart type, the type of Filtering 
applied to the data, and the Color scale used to display the data. The Color 
scale shows which measured signal level is mapped to which colour. The 
colour mapping can be changed using the Color Palette dialog, described 
further on in this section. The Data range indicator shows the range of 
possible measurement values that is occupied by the measured data.

The Chart bar is used to create new charts and to modify their properties. 
The chart configuration of the Imaging and Spectroscopy window can be 
saved to a file. The chart configuration of the measurement documents is 
saved together with the document.

Elements of a Chart

Signal

Line selection arrow

Data range indicator

Color scale

Data filter

Chart range
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Storing and retrieving the chart arrangement
The chart arrangement of the Imaging and Spectroscopy windows is stored 
in a configuration file with the extension ‘.chart’. When the easyScan 2
software is started, a default arrangement is loaded from a file that is 
selected in the Controller Configuration dialog (section The Controller 
Configuration dialog (p.99)). Functions for storing and retrieving the chart 
arrangement are accessed via the menu ‘File>Chart Arrangement’.

‘Save’ saves the chart arrangement to the currently selected chart file. The 
name of this file is indicated in the status bar at the bottom of the main 
window.

‘Save as...’, saves the chart arrangement under a new file name. 

‘Load’ loads a previously saved chart file.

IMPORTANT
When you have not loaded another file, ‘Save’, will overwrite the original 
default chart arrangement file with the current settings. 

The Chart bar 

The properties of the charts are set using the Chart bar. The settings dis-
played in the Chart bar refer to the currently active chart. This chart is 
indicated by a grey line around the chart. A Chart is activated by clicking it 
with the mouse cursor.

The following buttons control the creation and modification of the charts.

 (Create new Chart)
Creates a copy of the currently active chart and adds it as the last chart in 
the active window. Charts are first ordered top to bottom, then left to right. 
The window may have to be resized to see all charts.

 (Delete Current Chart)
Removes the currently active chart.

 (Chart type)
The chart type:

Line graph data is displayed as a plot. Points outside the range of 
4



THE CHART BAR 
the scanner are displayed in red. The displayed line is 
selected by dragging the Line selection arrow in a 
Color map or Shaded map chart (figure Elements of a 
Chart (p.123)). 

Color map data is encoded in a color scale

3D view data is shown as a 3-dimensional representation in a 
parallel perspective, see Changing the appearance of the 
3D view (p.127)

Shaded map creates an impression of the surface with lighting from 
the left. This is achieved by combining the topography 
with its derivative.

Dual line graph both the Forward and the Backward data (when avail-
able) are displayed as in the ‘Line graph’. The line of 
the data type selected in ‘Signal’ is black, the line of the 
reverse direction data is grey. 

 (Data filter)
The way data is processed before it is displayed, evaluated or exported:

Raw data the data is not processed.

Data represented using different chart types
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Mean fit the mean value of each line of data points is calculated 
and then subtracted.

Line fit the best fit line for each line of data points is calculated 
and then subtracted.

Derived data the difference between two successive data points 
(derivative) is calculated.

Parabola fit the best fit parabola for each line of data points is cal-
culated and then subtracted.

Polynomial fit the best fit fourth order polynomial for each line of 
data points is calculated and then subtracted.

 (Signal)
The input channel that is displayed. The available signals depend on the 
operating mode, the status of the User input (section The Operating mode 
panel (p.84)) and the measurement mode (section The Imaging panel
(p.112)).

 (Optimise Chart range)
Adjust the chart scale so that it optimally fits the measurement data.

 (Decrease Chart range)
Halves the chart scale, thereby increasing feature contrast / height.

 (Increase Chart range)
Doubles the chart scale, thereby decreasing feature contrast / height.

 (Chart properties dialog)
Opens the chart properties dialog.

The Chart properties dialog

Chart range
Span
The signal span that corresponds to the full chart scale. Increasing Span 
decreases the feature contrast. The current Span is also displayed next to the 
color bar / axis in the chart

Center
The signal that corresponds to the center of the chart scale.
6
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Auto set
When active, the chart scale is automatically set to optimally fit the meas-
urement data, as it is being acquired. Clicking  has the same effect as 
clicking the Optimise Chart range button.

Chart size
Size
The size of the chart in pixels.

Show Axis
When active, the labels in charts and the color-bar in ‘Color map’ window, 
are displayed.

Changing the appearance of the 3D view
Always click and hold the left mouse button on the 3D view chart while 
changing the 3D view. The surface is reduced in feature complexity as long 
as the left mouse button is pressed. Press the following additional keys/
buttons to determine what chart property is changed:

Surface rotation mouse left/right

Surface tilt mouse up/down.

Size displayed surface‘Ctrl’- key + mouse up/down

Surface position ‘Shift’-key + mouse up/down/left/right

Z-scale magnificationleft mouse button + right mouse button + mouse up/
down

Light source direction (360°)‘Shift’+‘Ctrl’-key + mouse left/right
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Light source height (0°-90°)‘Shift’+‘Ctrl’-key + mouse up/down

The lowest height of 0° corresponds to ‘sunset’ lighting, the highest height 
corresponds to mid-day lighting at the equator.

The Chart Properties “Span” and “Center” can be used to cut off high and 
or low features of the surface.

Tip
To create good-looking 3D images you can use any of the following fea-
tures:

• Use the Tools ‘Correct Scan Line Level’, ‘Glitch’ and ‘Noise reduction’ 
filters to remove unwanted measurement artefacts.

• Set the light source direction to 90° (parallel to the scan lines) 

• Click  once or twice until no clipping of high features is visible (or 
adjust the “Span” and “Center” Properties).

The Color Palette dialog

The color palette dialog is reached via the menu item ‘Options>Config 
Color palette...’. The color palette is used to map the display range of the 
measured values to a color. Three different palette types are available: 

Black&White The color map is a linear grey scale

Color The color selection uses the HSB-color model where 
the color (H) is set in ° value. The color is selected by 
8
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entering a number or by clicking a color in the color 
bar.

Look Up Table A user definable palette (with max. 256 color entries) 
can be selected. This palette is stored in a ‘.lut’ file that 
contains an ASCII table with RGB color values. A dif-
ferent look up table can be selected by clicking the 
‘Browse...’ button.

The Data Info panel

The Data Info panel displays the parameters of the active measurement and 
the current tool results.

Data Info Panel: Display of measurement parameters
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Quick Evaluation Tools

The easyScan 2 software has several tools that allow quick evaluation of a 
measurement while it is being acquired. This helps find optimal measure-
ment settings. For more elaborate evaluations, the optional Nanosurf Anal-
ysis or the Nanosurf Report software package can be used (section Creating 
a report (p.142)).

The quick evaluation tools are activated using the Tools bar or the Tools 
menu. The number of tools available depends on the type of the currently 
active chart. The evaluation results are displayed in the Tool Results panel.

IMPORTANT
All results are calculated after the ‘Data filter’ has been applied to the data. 
The results will generally vary when a different ‘Data filter’ option is used.

The Tool Results panel 

The Tool Results panel displays the results of the currently active tool. The 
panel should automatically become visible when a tool is selected. To make 

the panel visible, click  in the navigator. The contents of the tool results 
panel depend on the tool that is active. It will always contain a Cursor posi-
tion and a Tool status section, and may also contain a Tool result and a Tool 
chart section. Because the content of the Tool Results panel depends so 
strongly on the active tool, this panel is described in more detail with each 
of the tools.

The Tools bar

Properties of the measurements can be evaluated numerically using the 
tools. The tools are activated via the corresponding menu item or by click-
ing the respective button in the tool bar. Tools can be used in all charts, 
both during measurement and off-line. Before using a tool on a chart, acti-
vate the chart by clicking onto it. To stop using a tool, select another tool, 
or click its button a second time.
0
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 Measure Length
Starts measuring the distance and signal difference between two points. The 
measurement results are displayed in the Tool Results panel.

The two points are defined by drawing a double arrow. The first point is 
defined by the mouse cursor position where the left mouse button is 
clicked, the second point by the position where the button is released. 
When the mouse is not moved between clicking and releasing, an arrow 
parallel to the X*-axis is drawn.

The direction of the arrow can be adjusted by dragging its end markers; it 
can be moved by dragging the centre marker.

 Measure Distance
Starts measuring the distance between two parallel lines. The measurement 
result is displayed in the Tool Results panel.
Distance is measured by drawing two lines in the chart. The first point of 
the first line is defined by the mouse cursor position where the left mouse 
button is clicked, the second point by the position where the button is 
released. When the mouse is not moved between clicking and releasing, a 
line parallel to the X*-axis is drawn. After releasing the mouse button, a 
second parallel line sticks to the mouse cursor, that is released by clicking 
its desired position. The direction of the parallel lines can be adjusted by 
dragging their end markers; they can be moved by dragging the centre 
marker.
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 Measure Angle
Starts measuring the angle between features in the measurement. The meas-
urement result is displayed in the Tool Results panel. In Line graph-type 
displays, this tool can only be used when the signal displays height data.

The angle is measured by drawing two meeting lines in the chart. The first 
point of the first line is defined by the mouse cursor position where the left 
mouse button is clicked, the second point by the position where the button 
is released. When the mouse is not moved between clicking and releasing, 
a line parallel to the X*-axis is drawn. After releasing the mouse button, the 
end of the second line sticks to the mouse pointer. The end is released by 
clicking its desired position. The angle can be changed by dragging the 
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line’s end point markers or the corner mark; it can be moved by dragging 
the line’s centre markers.

 Create Cross Section
Displays and can create a new measurement document containing a line 
cross-section of a Color map or Line View display. The line is displayed in 
the Tool Results panel. The line can be stored in a new measurement doc-
ument.

The line is defined by drawing an arrow. The arrow points toward the for-
ward direction of the line. The start of the arrow is defined by the mouse 
cursor position where the left mouse button is clicked, the end of the arrow 
by the position where the button is released. When the mouse is not moved 
between clicking and releasing, an arrow ending in the centre of the meas-
urement is drawn. The direction of the arrow can be adjusted by dragging 
its end markers; it can be moved by dragging the centre marker.

A new measurement document containing the line section is created by 
double clicking the graph, or by clicking ‘Cut out line’ in the Tool Results 
panel.
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 Cut Out Area
Creates a new measurement document containing a subsection of an exist-
ing measurement. The size and area of the area is displayed in the Tool 
Results panel.

One corner of the area is defined by the mouse cursor position where the 
left mouse button is clicked, the opposite corner by the position where the 
button is released. When the mouse is not moved between clicking and 
releasing, an area is defined that has a size of 33% of the current measure-
ment, and is centred on the clicked location. Once an area is defined, it can 
be resized by dragging one of its corners, and moved to the desired position 
by dragging its centre point. It is possible to define a rectangular (i.e. non-
square) area by pressing the ‘Shift’ key whilst dragging a corner.

A new measurement document containing the area is created by double 
clicking the graph, or by clicking the ‘Cut out area’ button in the Tool 
Results panel.

 Calculate Line Roughness
Calculates certain roughness parameters along a line. Both the selected line 
and calculated values are displayed in the Tool Results panel.
The cross-section is selected in the same way as with the Cut out Line tool.
The calculated parameters are stored in the measurement document when 
the ‘Store’ button in the Tool Results panel is clicked.
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 Calculate Area Roughness
Calculates certain roughness parameters of an area. The calculated values 
are displayed in the Tool Results panel.
The parameters are calculated as follows:

 

The Roughness Average, Sa

The Valley depth, Sv

Sv = lowest value
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The area is selected in the same way as with the Cut out Area tool.
The calculated parameters are stored in the measurement document when 
the ‘Store’ button in the Tool Results panel is clicked.

Tip
The Area Roughness tool can be used to determine the mean height differ-
ence between two plateaus with more accuracy than with the ‘Measure Dis-
tance’ tool. To determine the mean height difference, select an area on each 
plateau, and calculate the difference between their Sm-values. 

 Correct Background
Removes the effect of a wrong scan plane when the ‘average’ and ‘plane’ 
Data filter options do not give satisfactory results. This may occur when the 
scan lines in different parts of the measurement have a different average 
height. An example of such a measurement is shown in figure Correct Back-
ground.
To use the tool, select three points that should be on the same height. This 
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is done with in the same way as the angle tool. The selected points are the 
end points of the two connected lines.
After clicking the ‘Execute’ button in the Tool Results Panel, the plane that 
is defined by the three points is subtracted from the measurement. To get 
useful results, the Data filter option for the display in which you draw the 
line should generally be ‘Raw data’.

 Correct scan line levels
Removes the effect of drift when the ‘average’ and ‘plane’ Data filter options 
do not give satisfactory results. This may occur when the scan lines in dif-
ferent parts of the measurement have a different average height. An example 
of such a measurement is shown in figure Correct scan line levels.
To use the tool, draw a line through points that should have the same height 
in the same way as with the Measure Length tool.
After clicking the ‘Execute’ button in the Tool Results Panel, the average 
level of each scan line is adjusted so that all points along the drawn line have 
the same height. To get useful results, the Data filter option for the display 
in which you draw the line should generally be ‘Raw data’ or ‘Mean fit’.

 Glitch Filter
The Glitch Filter removes the effect of small defects in the image such as 
single short glitches in the scan. Compared to the Noise Filter, it has the 
advantage of not reducing resolution on step edges. The glitch filter is 

 

Correct Background: left: uncorrected image, the end points of the lines have been moved to points 
that should have the same height; right: corrected image
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implemented as a Median filter on a 3x3 pixel matrix.
To apply the filter, activate the color map chart that is to be filtered, then 
click the Glitch Filter button in the Tools bar. A new Measurement docu-
ment with the filtered data is created.

 Noise Filter
The Noise filter removes high frequency noise from the image, but applying 
the filter will also decrease the resolution of the image. The Noise Filter is 

 

Correct scan line levels: left: uncorrected image with a line through points that should be at the 
same height; right: corrected image

 

Glitch Filter: left: unfiltered image with some glitches where the tip lost contact with the sample; 
right: corrected image
8
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implemented as a convolution with a 3x3 pixel Gaussian kernel function.
To apply the filter, activate the color map chart that is to be filtered, then 
click the Noise Filter button in the Tools bar. A new measurement docu-
ment with the filtered data is created.

Tip
Filters are especially useful for improving the appearance of 3D views.

Applying filters may changes the result of the other tools. This may result 
in incorrect results when evaluating sample roughness.

 

Noise Filter: left: unfiltered image of AFM measurement on HOPG; right: filtered image
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Storing measurements and further data 
processing

Storing and Printing measurements

Storing and Printing of measurement documents can be performed using 
the File menu. The functions Open, Save and Print are also available via the 
File bar.

Menu item ‘File’ contains the items for opening , closing, saving , and 
printing  the measurement documents and for exiting the program. In 
the following only the special functions are mentioned. 

 Open
Opens a dialog for opening Nanosurf ‘.nid’ or ‘.ezd’ (easyScan 1) files. The 
same dialog is opened using the menu ‘File>Open...’. It is possible to select 
more than one file at the same time by using the ‘Shift’ and ‘Ctrl’ keys.

 ‘Save’ and ‘Save as...’
Save a measurement document in Nanosurf image data format (file exten-
sion ‘.nid’). The same dialog is opened using the menu ‘File>Save’ and 
‘File>Save as...’. 

Export >Current Chart as / Current document as
Exports either the active chart or the whole active measurement document 
for use in other programs or image processing software. Available data types 
for documents are windows bitmap (.bmp), 16 bit data file (.dat), plot file 
(.plt). For Charts, additional available data types are comma separated z 
values (.csv), and (X,Y,Z)-points (.csv).

When the data is exported using the function ‘Export>Current document 
as...’, every Chart in the measurement document is stored in the export file 
consecutively. In the binary format, the blocks of data from each Chart are 
stored directly one behind the other. In the ‘ASCII’ text format the blocks 
of data for each Chart are separated by two empty lines.
0
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Windows Bitmap (.bmp)

A Windows Bitmap image is suitable for including in documents, e.g. word 
or image processing software. The exact image as seen on the computer 
screen will be saved in the file (‘screen shot’).

Data file 16Bit (.dat) 

A binary data file can be processed in image processing software. This 
‘binary’ data format contains only the measured data. The data is stored 
consecutively line by line upwards as 16-bit values (-32768 - +32767). The 
data is first processed using the settings chosen in the Data filter setting of 
the Chart bar.

Plotfile ASCII (.plt)

This is an ‘ASCII’ text format which contains the measured data as well as 
a small header with a description of the scan. The data is stored using the 
setting ‘Data filter’ in the ‘Chart bar’. A measurement as a plotfile can be 
used for detailed data analysis by various mathematical software packages 
such as MathLab or plotted by GnuPlot.

• If ‘Line graph’ is selected as ‘Display’ in the ‘Chart bar’, only the visualised 
lines will be stored. Each data point is stored as a pair of floating point 
numbers on a separate line. The number pairs are separated by a blank 
character (SPACE). 

• If any other chart type is selected, all measured values are stored. All val-
ues in a data line are stored on a separate line in the text file. An empty 
line is inserted after every data line. The data lines are stored from the 
bottom to the top. A small header at the beginning of the first data line 
contains the names of the channel and frame, as well as x-, y-, and z-
ranges with their physical units.

Comma separated z values (.csv) 

This format stores all the measured data in a chart, as a matrix of floating 
point numbers in ASCII format separated by a ‘comma’ and ‘SPACE’ char-
acter. This enables easy data exchange with commonly used spread sheet 
and database applications.
141



STORING MEASUREMENTS AND FURTHER DATA PROCESSING

14
(X, Y, Z)-Points (.csv) 

This format stores the coordinates of all measured points in a chart as a list 
of floating point number pairs. For Line graphs, only X and Z points are 
exported.

 Print, Print preview...
Prints the currently selected measurement document together with the val-
ues shown in the Data Info panel.

Creating a report

The Nanosurf Report software package offers a powerful and extensive set 
of analysis functions. Complex analyses can be created interactively, and 
then displayed and printed in visually appealing reports. These reports can 
then be used as templates to apply the same analysis to another measure-
ment.

The Report software is started from the easyScan 2 software by either click-

ing , or using the Report menu. When a measurement is opened by the 
report software, it will import all measurement channels that are displayed 
in the current measurement document.
2



CREATING A REPORT
IMPORTANT

• After a fresh installation of the Report software, the Report software has 
to have run at least one time before you can automatically start it from 
the easyScan 2 software. To run the Report software for the first time, 
select it from the MS Windows ‘Start’ menu.

• If you do not save the measurement in the easyScan 2 software, but only 
save the report, the data in measurement channels that were not displayed 
is lost.

• A measurement document should only display those channels that are 
used in a template. When a template is applied to a measurement docu-
ment that displays different, or a different number of measurement chan-
nels than the template uses, the results may not be correct.

The Report generator configuration dialog is used to configure the behav-
iour of the Navigator Icon and the Report menu. For an in depth introduc-
tion to the Nanosurf Report software, refer to the Introduction section of 
the Nanosurf Report on-line help.

The Report Menu

New Report
An empty report is opened.

Add Measurement
The currently active measurement is added to the currently opened report.

Apply Template...
Opens a dialog that allows you to select a template that is applied to the 
currently active measurement.

Template list
The template list is a list of the templates that are stored in the template 
directory (section The Report generator configuration dialog (p.144)). Select-
ing a template applies this template to the currently active measurement.
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The Report generator configuration dialog
The Report generator configuration dialog is used to configure the behav-
iour of the Navigator Icon and the Report menu. It is opened using the 
menu ‘Options>Config Report...’.

Navigation bar

Determines what happens when the  icon is clicked. The check box 
determines whether the active measurement is evaluated using a template. 
The Browse-button is used to select the template that is used when the icon 
is clicked.

Report menu
Determines which templates are displayed in the lower part of the Report 
menu. The Browse-button allows the selection of the directory where the 
templates are stored.
4



THE SCRIPT MENU
Automating measurement tasks

The Nanosurf easyScan 2 STM Scripting Interface is an optional compo-
nent for automating measurement tasks. It offers several possibilities to 
automate measurement tasks:

• Create scripts inside the easyScan 2 software.

• Create external software that controls the easyScan 2 software.

This chapter describes the user interface features that are related to creating 
scripts inside the easyScan 2 software.

After purchasing it, the Scripting Interface must be activated using the Edit 
Access Codes dialog (section The Edit Access Codes Dialog (p.101), or follow 
the instructions on the Access code certificate delivered with the instru-
ment.)

For more information about the automating measurement tasks, and the 
available script commands, refer to the Programmers Manual. This manual 
is available as an on-line help file, that can be opened via the windows Start 
menu: ‘Start>Program files>Nanosurf>Nanosurf easyScan 2 STM>easy-
Scan 2 STM Programmers Manual’.

The Script Menu

The scripting functions of the easyScan 2 software are reached via the 
entries in the Script menu:

Script Editor...
Opens the Script Editor dialog.

Run From File...
On selecting this menu entry, a file dialog appears that allows selecting a 
script file by browsing. When the script is error free, the script will start 
executing on clicking the ‘Load’-button. Otherwise, and error message with 
an error description will appear.
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Other entries
All scripts in the script directory are displayed below the Run From File 
menu entry. Selecting one of these entries starts the corresponding script. 
The example script ‘Show Remain Scantime’, which is installed in the 
default installation, should normally be listed here.

The Script Editor

The easyScan 2 software has an simple integrated Script Editor that allows 
editing, running, loading and saving scripts. The can be used in parallel 
with other application windows, so you can work with other parts of the 
application while editing a script. The Script Editor is accessed via the 
menu ‘Script>Script Editor...’.

Editor field
In the editor field in the center of the dialog you can edit scripts.

Run Button
Starts the currently loaded script. If there is an error in the script, a dialog 
box will appear.

The script editor
6



THE SCRIPT CONFIGURATION DIALOG
The Script Configuration Dialog

The Script Configuration Dialog allows you to set the search path for the 
scripts that are displayed in the Script menu. The dialog is accessed via the 
menu entry ‘Options>Config script...’.
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Approach 104
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Config Controller 99
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Config Scan Head 96
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Operating windows
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